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ความรู้พ้ืนฐานเก่ียวกับการตัดต่อวิดีโอ 
นายอภิภู สิทธิภูมิมงคล 

หอสมุดและคลังความรู้มหาวิทยาลัยมหิดล 
 
ความหมายของการตัดต่อวิดีโอ 
 การตัดต่อ หมายถึง การเปลี่ยนภาพและเสียงจากหนึ่งช็อต (Shot) ไปยังช็อตต่อไปโดยให้
มีความต่อเนื่องและเรียงล้าดับเร่ืองราว ไม่มีการกระโดดหรืออิริยาบถซ้้าซ้อนกัน โดยรักษาคุณภาพของภาพ
และเสียงให้กลมกลืนกันโดยตลอด  
ความส าคัญของการตัดต่อวิดีโอ     
 1. ช่วยเชื่อมต่อภาพ  ในการถ่ายวิดีโอนั้นไม่นิยมแช่กล้องจับภาพหรือฉากใดนิ่งนานๆ 
เพราะจะท้าให้ผู้ชมเบื่อหน่าย ดังนั้นจึงมีการถ่ายเป็นช็อตส้ันๆ จับภาพในมุมต่างๆ กัน ถ้าเป็นการถ่ายท้า
ด้วยกล้องเดียวก็จะต้องน้าภาพทั้งหมดเหล่านั้นมาเรียงล้าดับเข้าด้วยกันให้ถูกต้องตามเร่ืองราวหรือตามบท
วีดิโอ 
 2. ช่วยแก้ไขส่วนบกพร่อง ในการถ่ายวิดีโอบางครั้งมีการระมัดระวังและพิจารณากันอย่าง
รอบคอบแล้วก็ตาม ยังมักจะพบข้อบกพร่องอยู่เสมอ การตัดต่อสามารถช่วยได้โดยการตัดภาพที่ไม่ต้องการ
ออกไปหรือแทรกภาพที่ดีเข้าไปแทนที่ หรือต้องการแต่ภาพที่ไม่ต้องการเสียงที่มากับภาพนั้นก็สามารถเอา
ออกไปได้ 
 3. ช่วยก าจัดเวลา  ในการถ่ายวิดีโอรายการต่างๆ โดยเฉพาะที่เป็นรายการส้าหรับ
ออกอากาศนั้น เวลาเป็นเร่ืองส้าคัญมากจ้าเป็นที่จะต้องถ่ายให้ได้เวลาตามที่ก้าหนด แม้ว่าจะถ่ายภาพที่ดีๆ 
สวยๆ และมีประโยชน์กับเร่ืองที่จะเสนอมากเพียงไร ก็จ้าเป็นจะต้องเลือกภาพนั้นมาตัดต่อให้ได้ความยาว
พอเหมาะกับเวลาที่ก้าหนดเท่านั้น ดังนั้นเจ้าหน้าที่ตัดต่อล้าดับภาพก็จะต้องใช้กระบวนการตัดต่อนี้
ปรับแต่งตัดภาพส่วนเกินออกไป หรือแทรกบางภาพเพิ่มเข้ามาเพื่อให้ได้เวลาที่พอดี    
 4. ช่วยสร้างเรื่องราวอย่างต่อเนื่อง การล้าดับภาพเป็นการน้าภาพแต่ละฉากแต่ละตอนมา
เช่ือมต่อเข้าด้วยกัน ถ้าเป็นการต่อเช่ือมภาพอย่างมีศิลป ะด้วยความคิดสร้างสรรค์ ผู้ชมจะรู้สึกต่อเนื่องใน
เร่ืองราวที่เช่ือมต่อกันอย่างเป็นล้าดับนั้น ให้รายละเอียดมากพอเท่าที่ผู้ชมอยากจะรู้ ให้ความรู้สึกและ
อารมณ์ตามที่ควรจะเป็น ทั้งนี้หมายถึงว่าในขั้นตอนการถ่ายท้านั้นต้องได้ภาพที่ดี มีรายละเอียดเพียงพอ มี
ทั้งภาพขนาดไกล ขนาดกลาง ภาพถ่ายใกล้และภาพหลายๆ มุมของแต่ละฉากแต่ละตอน เจ้าหน้าที่ตัดต่อจึง
จะสามารถเลือกภาพมาตัดต่อได้ตามต้องการ   
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วัตถุประสงค์ของการตัดต่อวิดีโอ 
 ในการตัดต่อมีวัตถุประสงค์อยู่ 5 ประการ ดังนี้ (สุชาติ พรหมปัญญา, 2544 : 26) 
 1. เพื่อคัดเลือก  การถ่ายวิดีโอแม้มืออาชีพก็ยังต้องถ่ายท้ากันหลายๆ รอบ ไม่ต้องพูดถึง
วิดีโอที่เราถ่ายกันเองประเภทม้วนเดียวจบ จ้าเป็นอย่างย่ิงที่จะต้องคัดเลือกเอาเฉพาะช่วงที่ดีที่สุด ส่วนที่
เหลือตัดทิ้งไป 
 2. เพื่อล าดับภาพ เมื่อคัดเลือกตอนต่างๆ มาแล้วก็ต้องน้ามาเรียงล้าดับให้เป็นไปตามเนื้อ
เร่ืองหรือสคริปต์ที่วางไว้ 
 3. เพื่อปรับความยาว หลังจากที่น้าตอนต่างๆ มาเรียงกันแล้ว ความยาวทั้งหมดอาจจะสั้น
หรือยาวเกินไป จึงต้องมีการตัดออกหรือหามาเพิ่ม และปรับต้าแหน่งเข้าออกและความยาวของแต่ละท่อน
ให้เหมาะสม 
 4. เพื่อปรับแต่งแก้ไข  ตอนที่เราเลือกมาอาจมีข้อบกพร่องในเร่ืองแสง สีและสิ่ง
แปลกปลอมต่างๆ เข้ามา การตัดต่อจะท้าให้เราได้แก้ไข ลบออกหรือปรับแต่งให้แต่ละท่อนมีความ 
กลมกลืนกัน  
 5. เพื่อปรุงแต่ง เป็นการเพิ่มสีสันเช่นการใส่เสียงดนตรี เสียง Effect การใส่  Transition การ
ซ้อนตัวหนังสือ  จะท้าให้วิดีโอมีความน่าดูย่ิงขึ้นอย่างไรก็ตาม การใช้เทคนิคพร้่าเพร่ือก็อาจท้าให้ดูเลอะ
เทอะ และลดความน่าสนใจของเนื้อหาลงได้ เช่นกัน วิดีโอจะสมบูรณ์ไปไม่ได้ ถ้าขาดการจัดการเร่ืองเสียง
ที่ดี การแทรกค้าบรรยาย การปรับความดังของช่วงต่างๆ การแพนซ้ายขวาของเสียง การเพิ่มเสียงดนตรีหรือ
เสียงเพลงประกอบ รวมทั้งการเพิ่มเสียงเทคนิคต่างๆ ลงไปในวิดีโอถือเป็นเสน่ห์ที่จะท้าให้เกิดความ
ประทับใจได้อย่างย่ิงทีเดียว (ดลใจ อุดมสิน, มปป.: 28-29) 
ระบบการตัดต่อวิดีโอ 
 แบ่งออกได้เป็น 3 ประเภทดังนี้คือ  
 1. ระบบลิเนียร์ (Linear) 
 2. ระบบนอนลิเนียร์ (Non-Linear) 
 3. ระบบไฮบริดจ์ (Hybrid) 
 ระบบลิเนียร์ (Linear) เป็นวิธีล้าดับภาพไปตามล้าดับอย่างต่อเนื่องกันไม่สามารถกระโดด
ไปท้างาช่วงใดช่วงหนึ่งที่มีความพร้อมมากกว่าได้ เป็นระบบการตัดต่อม้วนเทปวิดีโอเป็นหลักอย่างน้อย 2 
เครื่อง คือตัวเล่น 1 เครื่อง กับตัวบันทึกอีก 1 เครื่อง เรียกการตัดต่อแบบนี้ว่า A/X Roll กรณี 
ต้องการท้าเทคนิคการเปลี่ยนภาพจากภาพหนึ่งไปอีกภาพหนึ่ง (Transition) จ้าเป็นต้องใช้เครื่องเล่นเทป
เพิ่มขึ้นอีก 1 เครื่อง รวมเป็น 2 เครื่อง เรียกว่า A/B Roll การท้างานระบบนอนลิเนียร์ จะต้องมีชุดควบคุม
เครื่องเล่นเทป (Edit Controller) เครื่องสลับภาพ (Switcher) เครื่องใส่เอฟเฟ็กต์ (Effect Generator) รวมทั้ง
อุปกรณ์ซ้อนตัวหนังสือ (Character Generator) โดยที่อุปกรณ์ควบคุมทั้งหมด อาจจะรวมอยู่ในอุปกรณ์เพียง
ช้ินเดียวหรือแยกกันทั้งหมดก็ได้ 
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 กรณีที่มีการแก้ไขจ้าเป็นจะต้องท้าใหม่ทั้งหมดตั้งแต่จุดที่แก้ไขไปจนถึงจุดสุดท้ายหาก
การแก้ไขนั้นท้าให้ความยาวของงานเปลี่ยนแปลงไป ที่ส้าคัญการใช้เทปส้าหรับตัดต่อสองหรือสามตัวเป็น
การไม่ประหยัดเป็นอย่างย่ิง เพราะนอกจากเทปเหล่านี้จะมีราคาสูงแล้ว ยังจ้าเป็นต้องเสียค่าใช้จ่ายในการ
ซ่อมบ้ารุงทั้งทางอิเล็กทรอนิกส์และทางกลไก โดยเฉพาะอย่างย่ิงหัวเทปที่มีราคาแพง และจะต้องเปลี่ยน
ตามอายุใช้งานเป็นระยะๆ อย่างหลีกเลี่ยงไม่ได้ 
 ระบบนอนลิเนียร์ (Non-Linear) เป็นวิธีล้าดับภาพที่สามารถกระท้าในช่วงใดๆ ก่อนก็ได้
โดยไม่จ้าเป็นต้องเรียงล้าดับก่อนหลังของเนื้อหา การแก้ไขสามารถกระท้าได้อย่างอิสระ ส่วนหลังของงาน
จะย้ายไปมาเพื่อปรับไปตามการแก้ไขนั้น ฟิล์มภาพยนตร์คือตัวอย่างของส่ือที่เป็นนอนลิเนียร์ กรณีของภาพ
วิดีโอจะต้องถูกแปลงให้อยู่ในรูปของแฟ้มข้อมูลดิจิทัลของคอมพิวเตอร์เสียก่อน จึงจะท้างานแบบนอน
ลิเนียร์ได้ โปรแกรมล้าดับภาพจะน้าข้อมูลวิดีโอที่อยู่ในฮาร์ดดิสก์มาแสดงเป็นสื่อนอนลิเนียร์ที่มองเห็นได้ 
(Non-Linear Visual Media) บนเส้นเวลา (Timeline) เหมือนกับการท้างานกับฟิล์มภาพยนตร์ ดังนั้น
โดยทั่วไปจึงอธิบายการล้าดับภาพแบบนอนลิเนียร์นี้ว่า เป็นการล้าดับภาพโดยใช้ฮาร์ดดิสก์เป็นหลัก 
 ข้อดีของระบบนอนลิเนียร ์
 ระบบนอนลิเนียร์ (Non-Linear) เป็นระบบที่พัฒนาขึ้นมาเพื่อแก้ปัญหาของระบบลิเนียร์
เดิม โดยการย้ายวิดีโอที่เคยอยู่บนเทปไปเก็บไว้ในฮาร์ดดิสก์ของคอมพิวเตอร์ แล้วใช้โปรแกรมตัดต่อวิดีโอ
ที่มีให้เลือกใช้มากมายมาท้าการตัดต่อวิดีโอแทน หลังจากการตัดต่อเสร็จก็โอนย้ายงานที่อยู่ในฮาร์ดดิสก์ไป
เก็บไว้บนตัวเดิม ด้วยวิธีนี้ท้าให้ระบบนอนลิเนียร์ได้เปรียบระบบลิเนียร์หลายๆ อย่างดังนี้ 
 1. ประหยัดราคาและพื้นที่การท้างาน เพราะระบบนอนลิเนียร์ใช้เทปเพียงตัวเดียวก็ท้างาน
ได้ 
 2. ประหยัดค่าใช้จ่ายในการซ่อมบ้ารุงเทป เนื่องจากมีการใช้งานเทปน้อยมากปกติจะใช้
ตอนน้าวิดีโอเข้าและออกจากฮาร์ดดิสก์เท่านั้น 
 3. การค้นหาและคัดเลือกภาพท้าได้รวดเร็ว เนื่องจากการท้างานจะอยู่ในฮาร์ดดิสก์ทั้งหมด 
จึงท้าได้รวดเร็วและแม่นย้ากว่าสามารถไปยังจุดใดก็ได้ในทันที โดยไม่ต้องรอการกรอกลับไปกลับมา 
 4. สามารถท้างานในช่วงต่างๆ ได้อย่างอิสระ ไม่ต้องท้าตามล้าดับก่อนหลังต้ังแต่ต้นจนจบ 
 5. ผลิตงานที่ซับซ้อนได้ง่าย โปรแกรมล้าดับภาพปัจจุบันมีประสิทธิภาพสูงสามารถสร้าง
ไตเติ้ล กราฟิกและแอนิเมช่ันได้สะดวก สามารถซ้อนภาพได้หลายๆ ช้ันในเวลาเดียวกัน 
 6. คุณภาพสูง ระบบนอนลิเนียร์ปัจจุบันสามารถท้างานกับข้อมูลที่ไม่บีบอัด 
(Uncompressed) เลย หรือบีบแบบไม่สูญเสีย (Lossless Compression) หรือสูญหายแบบมองไม่เห็น (Visual 
Lossless) หรือแบบดิจิทัลดั้งเดิม (Native Digital) ได้ จึงให้คุณภาพของงานสูงสุดเหมือนกับต้นฉบับ 
นอกจากนี้งานที่ซับซ้อน เช่น การซ้อนภาพหลายๆ ช้ัน สามารถท้าได้ในคร้ังเดียวโดยไม่ต้องสูญเสียคุณภาพ
จากการโยนภาพกลับไปกลับมา 
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 7. ท้างานร่วมกันเป็นเครือข่ายได้ สามารถแบ่งกันท้างานใช้ทรัพยากรที่มีราคาแพงร่วมกัน 
เช่น เครื่องเล่นเทป, ฮาร์ดดิสก์, สแกนเนอร์ และแลกเปลี่ยนข้อมูลระหว่างกันโดยไม่ต้องเดินไปมา 
 8. เผยแพร่ข้อมูลในรูปดิจิทัลได้สะดวก ระบบนอนลิเนียร์สามารถผลิตหรือส่งแฟ้มข้อมูล
ส้าหรับ วิดีโอซีดี ดีวีดี วิดีเซิร์ฟเวอร์ อินเทอร์เน็ต และโทรทัศน์ดิจิทัลได้ทันที 
 ระบบไฮบริดจ์ (Hybrid) เป็นระบบลูกผสมที่สามารถตัดต่อวิดีโอได้ทั้งระบบลิเนียร์และ
ระบบนอนลิเนียร์ในตัวเอง การท้างานสามารถควบคุมเทปได้อย่างน้อย 3 เครื่อง เพื่อตัดต่อแบบ A/B/C Roll 
ได้ สามารถบันทึกสัญญาณวิดีโอลงบนฮาร์ดดิสก์ เพื่อตัดต่อแบบ A/B Roll บนฮาร์ดดิสก์ได้สามารถตัดต่อ
วิดีโอจากเทปร่วมกับวิดีโอที่บันทึกไว้แล้วบนฮาร์ดดิสก์ได้ สามารถสลับการท้างานจากเครื่องเล่นเทปไป
ฮาร์ดดิสก์หรือจากฮาร์ดดิสก์ไปยังเครื่องเล่นเทปทันที ระบบไฮบริด จ์นี้น้ามาใช้เพื่อเช่ือมต่อช่วงคาบเกี่ยว
ของการเปลี่ยนจากระบบลิเนียร์ไปสู่ระบบนอนลิเนียร์ โดยเฉพาะผู้ปฏิบัติงานที่ยังปรับตัวกับระบบ
คอมพิวเตอร์ไม่ทัน ปัจจุบันโปรแกรมตัดต่อระบบนอนลิเนียร์พัฒนาให้ใช้งานได้ง่ายขึ้น นักตัดต่อส่วนใหญ่
มีความคุ้นเคยกับคอมพิวเตอร์มากขึ้น จึงถือว่าได้ผ่านพ้นช่วงนั้นไปแล้ว ระบบไฮบริด จ์จึงเสื่อมความนิยม
ลงไปผู้ใช้งานสามารถเร่ิมต้นใหม่กับระบบนอนลิเนียร์ได้ทันที ตัวอย่างของระบบไฮบริด จ์ ได้แก่ Sony ES-
7 และ FAST Video Machine เป็นต้น  
อุปกรณ์ที่ใช้ในการตัดต่อวิดีโอ  การตัดต่อวิดีโอจะต้องมีอุปกรณ์ต่างๆ ดังต่อไปนี ้
 1. กล้องวิดีโอ เป็นกล้องที่ใช้ในการถ่ายข้อมูลเข้าสู่คอมพิวเตอร์ เพื่อท้าการตัดต่อโดยการ
ตัดต่อจะเน้นการตัดต่อในระบบ Non-Linear หรือการตัดต่อด้วยคอมพิวเตอร์เป็นหลัก ดังนั้นจึงต้องมีการ
ถ่ายข้อมูลเข้าสู่คอมพิวเตอร์ก่อน 
 2. การ์ดตัดต่อ  การถ่ายข้อมูลจากกล้องวิดีโอเข้าสู่คอมพิวเตอร์ จะต้องมีการ์ดตัดต่อ 
(Capture card) ท้าหน้าที่เป็นตัวกลางในการผ่านสัญญาณวิดีโอเข้าสู่คอมพิวเตอร์ และท้าหน้าที่ในการบีบ
อัดข้อมูลวิดีโอให้มีขนาดเล็กลง 
 3. สายส่งสัญญาณ  เป็นสายส้าหรับส่งสัญญาณจากกล้องวิดีโอเข้าสู่เครื่องคอมพิวเตอร์ 
หากกล้องที่ใช้เป็นแบบ Analog ก็จะใช้สายประเภท S-Video หรือ Component แต่ถ้าเป็นกล้องประเภท 
Digital ก็จะใช้สายประเภท IEEE 1394 หรือสาย DV เช่น สาย Fire wire, I. Link, m LAM เป็นต้น 
 4. ซอฟต์แวร์  หรือโปรแกรมส้าหรับการจับภาพวิดีโอ (Capture) ซึ่งคุณอาจจะใช้
โปรแกรมที่ได้รับมาพร้อมกับการ์ดท้าการ Capture ก็ได้ หรือจะใช้โปรแกรมอื่นๆ ก็ได้ เช่น WinDVR, 
PowerVCR, Pinnacle Studio, WinDVR, AVI_io_tral เป็นต้น ซึ่งบางโปรแกรมก็มีให้คุณสามารถดาวน์
โหลดมาทดลองหรือใช้งานฟรีก็มี 
 5. เครื่องคอมพิวเตอร์ ควรเป็นเคร่ืองที่มาความเร็วของซีพียูสูง ไม่ควรต่้ากว่า Pentium III 
500 MHz ควรเป็นเคร่ืองที่ใช้ฮาร์ดดิสก์ที่มีความเร็วสูง เช่น ความเร็ว 7200 rpm แบบ UDMA /66 หรือ 
UDMA/100 หากเป็นฮาร์ดดิสก์แบบ SCSI จะย่ิงดี และควรมีขนาดที่มากเพียงพอส้าหรับเก็บข้อมูลวิดีโอได้  
หลักพื้นฐานส าคัญในการตัดต่อวิดีโอ 
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 การตัดต่อเป็นการสร้างเร่ืองราวขึ้นมาให้สมบูรณ์ โดยให้ภาพและเสียงมีความต่อเนื่องกัน
โดยตลอด การจะท้าเร่ืองราวให้สมบูรณ์โดยการตัดต่อนั้นจะต้องค้านึงถึงหลักพื้นฐานส้าคัญดังต่อไปนี้  
 1. ความต่อเนื่อง (Continuity) การตัดต่อเทปวิดีโอต้องพยายามรักษาหรือสร้างความ
ต่อเนื่องในสิ่งต่อไปนี ้
  1.1 รายละเอียดของส่ิงที่ต้องการจะกล่าวถึง ผู้ชมรายการมักจะต้องการจดจ้าภาพ
ของบุคคลหรือสิ่งของจากช็อตหนึ่งไปยังอีกช็อตหนึ่งได้ ดังนั้นให้หลีกเลี่ยงการตัดต่อภาพจากภาพที่ 
เปลี่ยนระยะทางหรือมุมกล้องที่ไกลมากมาเป็นภาพที่ใกล้มาก หรือภาพถ่ายจากมุมด้านหน้าของคนที่ไกล
ตัดมาเป็นภาพถ่ายจากข้างหลังบุคคลเดียวกันที่ใกล้มาก แต่ถ้าจ้าเป็นต้องตัดต่อภาพแบบนี้ จะต้องเช่ือมโยง
สัมพันธ์ของภาพให้ต่อเนื่อง โดยค้าอธิบายว่าภาพนี้เป็นบุคคลเดียวกันกับที่เห็นในช็อตก่อนหน้านี้  
  1.2 สถานที่ในฉาก เพื่อให้เกิดความต่อเนื่องของภาพ จะต้องรักษาให้ต้าแหน่งของ
บุคคลหรือสิ่งของที่ปรากฏในภาพอยู่ในฉากเดียวกัน เช่น ฉากการสนทนาของ 2 คน ซ่ึงถ่ายข้ามไหล่ของแต่
ละคนเพื่อจับภาพของคู่สนทนานั้น ผู้ชมก็ต้องการที่จะเห็นว่าอีกคนนั้นก็ยังอยู่ในจอเหมือนกัน แต่จะ
เปลี่ยนไปถ่ายในมุมตรงข้าม และที่ส้าคัญเวลาถ่ายท้าและต้องย้ายกล้องก็ต้องค้านึงถึงเส้นแบ่งการสนทนา 
(Vector Line บางทีเรียกว่า Line of Conversation หรือ Conversation Axis หรือ Principal Axis) คือ จะต้อง
ตั้งกล้องถ่ายจากเส้นแบ่งด้านเดียวกัน มิฉะนั้นการตัดต่อภาพจะกระโดด หรือจะเป็นภาพการสนทนาที่หัน
หน้าไปทิศทางเดียวกัน 
  1.3 การเคลื่อนไหวของผู้แสดง การตัดต่อภาพให้อากัปกิริยาของผู้แสดงมีความ
ต่อเนื่องอย่างเป็นธรรมชาติมากที่สุด ให้ตัดภาพระหว่างการเคลื่อนไหวของผู้แสดง ไม่ใช่ก่อนและหลังการ
เคลื่อนไหวนั้น 
  1.4 สี สีสันของภาพมีความส้าคัญในการล้าดับภาพให้ต่อเนื่อง ถ้าฉากต่อเนื่องที่
เป็นฉากเดียวกันแต่ถ่ายท้าหลายครั้ง ต่างเวลากัน เมื่อน้ามาล้าดับเป็นเร่ืองราวต่อเนื่องกันต้องระมัดระวังว่า
อุณหภูมิสีของแสงแตกต่างกันหรือไม่ ซ่ึงจะเป็นเหตุให้สะดุดความรู้สึกของผู้ชม 
  1.5 เสียง เสียงจะต้องมีความสัมพันธ์กับภาพ การตัดต่อบางรายการต้องการใช้
เสียงจริงที่ได้บันทึกไว้ระหว่างการถ่ายท้าในบางช่วง เช่น เสียงการสัมภาษณ์ ในการตัดต่อค้าพูดที่ไม่
ต้องการออก ต้องระวังให้ค้าพูดนั้นลงจังหวะให้ดี ในช่วงค้าถามหรือค้าตอบ ส่วนบางตอนอาจต้องการให้
ได้เสียงประกอบพิเศษเข้าไป เพื่อแสดงเหตุการณ์ในสภาพแวดล้อมนั้นอย่างต่อเนื่อง เช่น เสียงแบคกราวน์ 
เสียงยวดยาน เสียงผู้คนโห่ร้อง เป็นต้น 
 2. ความซับซ้อน (Complexity) การตัดต่อภาพให้ได้เร่ืองราวที่น่าสนใจ ชวนติดตาม
มองเห็นรายละเอียดที่ซับซ้อนของเหตุการณ์นั้น จะสื่อความหมายให้ผู้ชมเข้าใจและซาบซึ้งในเร่ืองราวนั้น
มากขึ้น ซ่ึงการตัดต่อเทปวิดีโอให้เร่ืองราวต่อเนื่องธรรมดา ผู้ชมก็สามารถจะดูรายการนั้นได้อย่างรู้เร่ืองราว
ตั้งแต่ตั้งต้นจนจบว่าเหตุการณ์ด้าเนินไปอย่างไร แต่จะเป็นรายการที่ขาดรสชาติบางอย่าง ผู้ชมไม่ได้เห็นว่า
กล่าวจะถึงเหตุการณ์แต่ละตอนนั้น มีรายละเอียดที่สลับซับซ้อนอย่างไร การตัดต่อรายการแบบนี้ได้ จะต้อง
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ได้ภาพที่ถ่ายระยะใกล้แสดงรายละเอียดของส่วนประกอบในเหตุการณ์นั้นหลายๆ ภาพหลายๆ มุม ใช้
จังหวะในการตัดต่อแทรกภาพเข้าไปอย่างเหมาะสมหรือใช้เสียงดนตรีที่เร่งเร้า หรือเสียงแบคกราวด์ที่
สอดคล้องกับภาพ เพื่อให้เกิดความรู้สึกร่วมไปกับภาพนั้น 
 3. ความเป็นจริง (Context) การตัดต่อทุกชนิดต้องเสนอเร่ืองที่เป็นจริงแก่ผู้ชม โดยเฉพาะ
อย่างย่ิงในเร่ืองของข่าว ในการถ่ายท้าเหตุการณ์ใดๆ ก็ตาม ภาพที่ถ่ายจากเหตุการณ์นั้นจะมีทั้งส่วนที่สื่อ
ความหมายให้เห็นภาพรวมของเหตุการณ์ และก็อาจมีบางภาพที่อยู่ในเหตุการณ์จริงเช่นกัน แต่เป็นส่วน
เล็กน้อยที่มิได้มีความหมายว่าเหตุการณ์โดยรวมจะเป็นเช่นนั้น การตัดต่อเทปวิดีโออาจท้าให้ความเป็นจริง
บิดเบือนไปได้เช่น ตัดต่อข่าวการหาเสียงเลือกตั้งของนักการเมืองคนหนึ่ง มีภาพที่ช่างกล้องถ่ายมาเป็นภาพ
ขนาดใกล้ของคนที่มาฟังการปราศรัยแล้วนั่งหลับน้้าลายยืด 2-3 หยด แต่ความจริงแล้วภาพอื่นๆ ส่วนใหญ่
เป็นภาพฝูงชนที่แสดงความกระตือรือร้นในการฟัง ให้ความสนใจกับค้าปราศรัยนั้นมาก ถ้าเราตัดต่อเฉพาะ
คนที่นั่งหลับเข้าไป ก็เท่ากับว่าได้บิดเบือนความจริงไปจากเหตุการณ์ที่เกิดขึ้น ซ่ึงเป็นสิ่งที่ไม่ควรกระท้า  
 ส้าหรับภาพจากแหล่งภาพสะสมนั้นส่วนใหญ่จะเป็นภาพเกี่ยวกับเหตุการณ์หรือเร่ือง
ธรรมดาทั่วๆ ไป เช่น เมฆ ท้องฟ้า หาดทราย ฝนตก ฟ้าแลบ ยวดยาน ฝูงชน เป็นต้น ภาพเหล่านี้สามารถ
น้ามาใช้ได้ดีกับการตัดต่อเร่ืองราวที่สอดคล้องกัน แต่มิใช่น้าไปสอดแทรกเพื่อบิดเบือนความจริง 
 4. ความมีคุณธรรม (Ethics) เจ้าหน้าที่ตัดต่อเทปวิดีโอจะต้องเป็นผู้ยึดหลักคุณธรรมไม่ใช้
การตัดต่อเป็นเคร่ืองมือสร้างเร่ืองราวให้บิดเบือนไปจากเหตุการณ์ที่เป็นจริง นอกเสียจากจะเป็นรายการ
ละครหรือนวนิยายที่แต่งขึ้นมาเท่านั้น ต้องไม่ใช้ความคิดเห็นส่วนตัวของตนเองเป็นเคร่ืองตัดสินใจที่
สอดแทรกบางภาพที่มิได้มีความจริงปรากฏอยู่ ดังนั้นในการตัดต่อเทปวิดีโอท่านต้องค้านึงถึงความมี
คุณธรรม ระมัดระวังไม่ให้มีการแต่งเติมหรือบิดเบือนอันอาจท้าให้ผู้หนึ่ง ผู้ใดเกิดความเสียหายจากการตัด
ต่อของตัวท่าน 
เทคนิคการตัดต่อวิดีโอ 
 เทคนิคการเลือกใช้ภาพ   
  เทคนิคการเลือกใช้ภาพในการตัดต่อเทปวิดีโอ สามารถน้ามากล่าวไว้ได้ดังนี ้
 1. มุมกล้อง มุมกล้องในระดับที่แตกต่างกันจะท้าให้ความหมาย และความรู้สึกที่แสดง
ออกมานั้นแตกต่างกันออกไป 
 - ภาพมุมปกติ (Normal Angle Shot) เป็นมุมกล้องที่ใช้กันมากที่สุด ภาพจะอยู่ในระดับ
สายตา โดยยึดเอาสิ่งที่ถ่ายเป็นหลักไมใช่ระดับสายตาของผู้ถ่าย 
 - ภาพมุมสูง (High Angle Shot) ระดับของกล้องจะอยู่สูงกว่าวัตถุที่ถ่าย โดยถ่ายลงมา
ให้เห็นภาพแสดงถึงความต้อยต่้าขาดพลังภาพมุมสูงเหนือศีรษะ และปลายเท้าเป็นภาพที่มีระยะใกล้เข้ามา
มากกว่า ELS 
 - Medium Close Up (MCU) ภาพจะเน้นสิ่งที่ถ่ายมากขึ้น 
 - Close up (CU) เป็นภาพที่ถ่ายใกล้มากๆ จนฉากหลังแทบจะไม่มีความหมาย 
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 - Extreme Close up (ECU) เป็นภาพที่ถ่ายใกล้มากๆ จนสิ่งที่ถ่ายเป็นจุดเด่นเต็ม
จอโทรทัศน์ 
 2. การเคลื่อนกล้อง  
 - Pan คือ การเคลื่อนกล้องในแนว Horizontal คือ จากซ้ายไปขวาหรือจากขวาไปซ้ายใน
แนวนอน 
 - Till เป็นการเคลื่อนกล้องในแนวดิ่ง (Vertical) คือขาของกล้องอยู่กับที่แต่หัวกล้อง
ยกขึ้นในแนวดิ่ง (Till-Up) และกดลง (Till-down)   
 - Dolly คือ การเคลื่อนกล้องทั้งขากล้องและตัวกล้องเข้าไปใกล้หรือถอยหลังห่างจากผู้
แสดง 
 - Zoom เป็นการเคลื่อนเข้า-ออกเฉพาะเลนส ์
 3. การประกอบภาพหรือการจัดองค์ประกอบภาพ  การประกอบภาพนั้นไม่ใช่เพียงแต่จับ
ภาพออกมา แต่หมายถึงวิธีการควบคุมความต่อเนื่องทางความคิด ต้องให้ผู้ชมได้รู้ได้เห็นในสิ่งที่ตนเอง
ต้องการจะบอก ซ่ึงต้องไม่ท้าให้ผู้ชมไขว้เขวสับสนหรือหันเหความสนใจไปยังจุดอื่นที่ผิดไปจากเป้าหมาย
ที่วางไว้  
 เทคนิคในการเรียงล าดับภาพ 
 เทคนิคในการเรียงล้าดับภาพนี้ประกอบด้วยสิ่งที่ส้าคัญ 2 ประการ คือ  
 1. ความยาวของภาพหรือช็อต  การเปลี่ยนภาพแต่ละครั้งจะท้าให้ผู้ชมถกกระตุ้น
ความรู้สึกขึ้นอีกครั้งหนึ่ง แล้วความรู้สึกนั้นจะค่อยๆ ลดลงจนกระทั่งมีการตัดภาพอีกครั้งหนึ่ง ถ้าความยาว
ของช็อตพอเหมาะกับอารมณ์ของผู้ชม ผู้ชมก็จะถูกกระตุ้นตามจังหวะ ถ้าช็อตยาวเกินไปอารมณ์ของผู้ชมจะ
ราบเรียบไม่ตื่นเต้น แต่ถ้าช็อตส้ันเกินไปอารมณ์ของผู้ชมจะถูกกระตุ้นแต่เพียงบางเบาเพราะเกิดความเคย
ชิน 
  2. ความถี่ของการเปลี่ยนภาพ การเปลี่ยนภาพจากภาพที่หนึ่งไปสู่ภาพที่สอง หรือ
ถ้าจะเรียกง่ายๆ ว่าการตัดภาพนั้น ตามธรรมดารายการที่มีความยาว 30 นาทีจะมีความถี่ในการตัดภาพ 
ประมาณ 20 ครั้งแต่ความถี่นี้อาจจะเปลี่ยนแปลงได้ตามเนื้อเร่ืองของเร่ืองที่แสดง ถ้าเป็นเร่ืองที่แสดงถึงการ
เคลื่อนไหวที่รวดเร็ว เช่น การว่ิง การกระโดด อาจตัดภาพที่มีความถี่สูง ความจริงแล้วความยาวช็อต และ
ความถี่ของการเปลี่ยนภาพนี้มีความสัมพันธ์กันอยู่แล้ว (มหาวิทยาลัยสุโขทัยธรรมาธิราช, 2537 : 77 

โปรแกรม Adobe Premiere 
 

โปรแกรมตัดต่ อ Adobe Premiere ได้รับการพัฒนาและมีการเปลี่ยนชื่อเป็นรุ่นส้าหรับมืออาชีพ 
(Pro) ไปแล้ว หากนับจากเวอร์ช่ัน 6 จนถึงปัจจุบัน Adobe Premiere มีการประกาศเปลี่ยนเวอร์ช่ันไปดังนี้คือ 
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เวอร์ช่ัน 6.5, Pro 1.0 บางคนเรียกเวอร์ชัน 7.0, Pro 1.5 และล่าสุดคือ Adobe Premiere CS5 รุ่นปัจจุบัน ความ
แตกต่างจากเวอร์ชันเดิมกับเวอร์ช่ันใหม่จึงมีมากพอสมควร 

 
ล าดับข้ันตอนการท างานการตัดต่อ 

ในการใช้งานโปรแกรมตัดต่อวีดีโอไม่ว่าจะเป็นโปรแกรมใด รวมทั้ง Adobe Premiere cs3 มักจะมี
ล้าดับการท้างานดังนี้คือ 

1. สร้างโครงการ (new project) ใหม่  หรือ เปิดโครงการ (open project) ที่เคยบันทึกไว้แล้ว 
2. จับภาพและเสียง (capture) จากกล้องหรือเทป และน้าเข้า (import) ไปใช้ในโครงการ 
3. ดัดลอก ปรับแต่ง และล้าดับ ส่วนต่าง ๆ เข้าด้วยกัน (assembly and refine sequence) 
4. สร้างและซ้อนไตเติ้ล (title)  และ / หรือ กราฟิก (graphic) ลงบนภาพในจุดที่ต้องการ 
5. เสริมเอฟเฟ็กต์ (effect) และทรานซิชัน (transition) เพื่อความสมบูรณ์ 
6. ปรับแต่งและผสมเสียง (mix) ให้สอดคล้องสัมพันธ์กับภาพ 
7. ส่งผลงานออก (export)  ในรูปแบบต่าง ๆ ที่ต้องการ 

 

7 ข้ันตอนการท างานกับ Adobe Premiere cs3 
ข้ันที่ 1 สร้างหรือเปิดโครงการ 

เปิดโปรแกรม จาก  Icon ของพรีเมียร์บนเด สท็อป (Desktop) หรือเรียกจากรายการบนเมนู Start 
พรีเมียร์จะเร่ิมท้างานโดยแสดงเป็นโลโกพร้อมกับการโหลดส่วนประกอบต่าง ๆ ลงบนหน่วยความจ้า
จากนั้นพรีเมียร์จะให้เราเลือกระหว่างการสร้างโครงการใหม่ (New Project) กับเปิดโครงการเก่าที่เคยสร้าง
ไว้แล้ว (Open Project) โดยจะน้าเอาโครงการเก่าที่เคยเปิดท้างาน 5 ครั้งสุดท้าย (ถ้ามี) มาให้เลือกเพื่อความ
สะดวก แต่หากโครงการที่เราต้องการจะเปิดไม่มีช่ือในรายการ เราก็ต้องเลือก Open Project แล้วระบุ
เส้นทาง (path) และตัวแฟ้มที่ต้องการ 

 
 

 
 
 
 
 

 
รูปที่ 1.  แสดงทางเลือกในการสร้างโครงการใหม่ 
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กรณีสร้างโครงการใหม่ พรีเมียร์จะให้เราก้าหนดรายละเอียดของโครงการซ่ึงแบ่งเป็นสองกลุ่ม 
กลุ่มแรกจะเป็นกลุ่มที่มีการก้าหนดรายละเอียดไว้แล้วล่วงหน้า(Preset) ประกอบด้วยรายการ มาตรฐานที่ใช้
งานกันเป็นประจ้าให้เลือก เช่น DV-PAL และ DV-NTSC ซึ่งแยกย่อยเกี่ยวกับระบบเสียงลงไปอีกเช่น 
Standard 32 KHz หรือ 48 KHz เป็นต้น ส่วนอีกกลุ่มหนึ่งจะเป็นกลุ่มที่เราต้องการก้าหนดรายละเอียดเอง
ทั้งหมด (Custom Setting) กรณีกลุ่มที่จัดให้ไม่สอดคล้องกับโครงการใหม่  เราจะต้องมาใช้กลุ่มหลังนี้ เช่น
งานที่ท้ากับคลิปสื่อประสม (Multimedia) หรือมาจากวีซีดีหรือ MPEG-1 เป็นต้น  

 
 

 
 
 
 
 
 
 
 
 
 
 

รูปที่ 2 แบบโครงการที่พรีเมียร์จัดไว้ให้เป็นมาตรฐาน 
 

ความส้าคัญในการก้าหนดรายละเอียดของโครงการให้เหมาะสมก็คือคุณภาพและประสิทธิภาพใน
การท้างาน ในหลักการท่านจะต้องก้าหนดรายละเอียดให้สอดคล้องกับฟุตเทจ (footage) หรือคลิป (clip) ที่
จะน้ามาใช้เป็นหลัก เช่นความละเอียด การบีบอัด ระบบเสียง หากก้าหนดโครงการไว้ไม่ตรงกับคุณสมบัติ
ของคลิปที่ใช้ การแปลงภาพและเสียงจะถูกน้ามาใช้ในขั้นตอนต่าง ๆ อันเป็นการเพิ่มภาระของซีพียูจนท้า
ให้ระบบท้างานช้าลง ที่ส้าคัญการแปลงภาพและเสียงจะท้าให้คุณภาพลดลงจากเดิมด้วย 

กรณีที่ไม่ทราบว่าคลิปที่จะน้ามาใช้มีคุณสมบัติอย่างไร ให้น้าคลิปนั้นเข้าสู่โครงการใด ๆ แล้วไปดู
ที่กรอบพาแนล (Panel) Info เมื่อคลิกเลือกรายการนั้น หรือจะใช้วิธีคลิกขวาแล้วเลือกหัวข้อ Properties
รายละเอียดที่ส้าคัญของคลิปนั้น เช่น ชนิด(type) ขนาด (image size) อัตราการแสดงภาพ frame rate)  
จ้านวนบิดสี (pixeldepth) และ คุณสมบัติของเสียงต่าง ๆ ก็จะแสดงออกมาหลังจากก้าหนดราละเอียดให้กับ
โครงการแล้ว  อย่าลืมส่วนที่ส้าคัญที่สุดนั้นคือช่ือโครงการ (name) ซึ่งจะให้ท่านพิมพ์ลงไปที่บรรทัดสุดท้าย
ต่อจากต้าแหน่ง  (location)  ซึ่งเป็นที่เก็บแฟ้มของโครงการเราสามารถเลือก (browse) หาต้าแหน่งใหม่ให้
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แตกต่างจากที่โปรแกรมเลือกให้ก็ได้ ( ต้าแหน่งที่โปรแกรมเลือกให้สามารถเปลี่ยนใหม่ได้จากค้าสั่ง 
Project>Project Manager  บนแถบเมนู
 

พื้นที่ท างาน (Workspace) 
หน้าต่างหลัก (main windows) ของโปรแกรม เป็นสี่เหลี่ยมผืนผ้าใหญ่ที่สุดที่ครอบทุกส่วนของ

พรีเมียร์ไว้ เรียกว่า  หน้าต่างงานประยุกต์ (application window)ซึ่งจะแสดงออกมาหลังจากการเปิดโครงการ
แล้ว ในหน้าต่างหลักนี้จะประกอบด้วย แผงหรือพาแนล (panel) ท้างานหลายชนิดจัดวางไว้อยู่ภายใน
ลักษณะต่าง ๆ เรียกว่าพื้นที่ท้างาน (workspace) การท้างานแต่ละครั้งอาจจะมีการเปิดใช้งานและวาง
ต้าแหน่งพาแนลเหล่านี้ไม่เหมือนกัน พรีเมียร์จึงให้เราเปิด ปิด โยกย้าย ปรับแต่ง และจัดกลุ่มพาแนลเหล่านี้
ได้อย่างอิสระ นอกจากนี้ยังจัดพื้นที่ท้างานไว้ให้เลือกใช้อีก 4 แบบ ตามความเมาะสมของการท้างานคือ 
แบบ Editing, Effects, Audio, และ Color Correction  โดยเลือกจากค้าสั่ง  Window>Workspace  บนแถบ
เมนู  อย่างไรก็ตามปกติเมื่อเปิดโครงการคร้ังแรกพรีเมียร์จะเลือกพื้นที่ท้างานแบบ Editing  ให้ดังแสดงไว้
ในรูปที่ 3 

 
รูปที่ 3 แสดงพ้ืนที่ท้างานแบบ Editing 

ก่อนอื่นเรามาท้าความรู้จักกับสามพาแนลที่ส้าคัญบนพื้นที่ท้างานสักเล็กน้อย ส่วนพาแนลอื่น ๆ จะ
เป็นส่วนเสริมการท้างานจึงขอน้าไปอธิบายในภายหลังเมื่อถึงเวลาที่ต้องใช้มันจริง ๆ 

1. โครงการหรือโปรเจ็กต์ (project) เป็นแผงส้าหรับเก็บอัตถสาร (asset) หรือ คลิป (clip) วีดีโอ  
ภาพ  และเสียง รวมทั้งซีเควนซ์ (sequence) หรืองานตัดต่อแต่ละชุด อัตถสารเหล่านี้ได้มาจากการน้าเข้า 
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(import) แฟ้มที่เก็บอยู่ในตัวเก็บข้อมูล (storage)  เช่นฮาร์ดดิสก์ หรือ จากการจับ (capture) ภาพหรือเสียง
จากกล้องหรือเทปบันทึก แฟ้มที่จะน้ามาใช้ตัดต่อจะต้องเป็นแฟ้มที่พรีเมียร์สนับสนุนเช่น AVI, MOV, 
WAV และ PSD เป็นต้น  และจะต้องน้าเข้ามาเก็บในพาแนลนี้เสียก่อน ในพาแนลนี้จึงมีพื้นที่ส้าหรับแสดง
คุณสมบัติ (attribute) การเรียงล้าดับ (sort) และจอส้าหรับตรวจดู (preview) อัตราสารเหล่านั้นได้ กล่าวโดย
สรุป พาแนล Project ก็คือ ถัง (bin) หรือลิ้นชักส้าหรับเก็บเอกสารต่าง ๆ ที่จะน้าไปท้างาน (ตัดต่อ) บนโต๊ะ 
(ไทม์ไลน์) นั่นเอง 

2.  ไทม์ไลน์ (timeline) เป็นแผงที่ใช้จัดเรียงคลิปต่าง ๆ เพื่อประกอบให้เป็นเร่ืองราวตามที่ต้องการ 
เรียกว่า ‚ซีเควนซ์ ‛ ซึ่งประกอบด้วย ลู่ (track) ส้าหรับวางภาพและเสียงอย่างน้อยอย่างละหนึ่งลู่ การ
ปรับแต่ง ใส่เอฟเฟ็กต์ ทรานซิชัน จะท้างานบนไทม์ไลน์เป็นหลัก กว่า 80% ของ งานตัดต่อจะอยู่บนไทม์
ไลน์นี้   ไทม์ไลน์จึงมีเครื่องมือให้ใช้มากมาย เช่น เครื่องมือส้าหรับ ตัด เลื่อน ล็อก ทริม หมุน ฯลฯ  ไทม์
ไลน์จึงเปรียบเสมือนกับโต๊ะท้างานซึ่งน้าเอกสาร (คลิป) ที่อยู่ในลิ้นชัก (โครงการ ) มาจัดการบนโต๊ะ (ไทม์
ไลน์) นั่นเอง ไทม์ไลน์กับซีเควนซ์จึงแยกกันไม่ออก และมักเรียกปะปนกันเสมอ โดยเฉพาะผู้ที่คุ้นเคยกับ
เวอร์ชันเก่าที่มีซีเควนซ์ได้เพียงอันเดียว 

3.  จอภาพ (monitor) เป็นจอส้าหรับดูภาพ แบ่งเป็นสองชนิดคือจอซอร์ส (source) และจอ
โปรแกรม (program) จอซอร์ส ใช้ส้าหรับดูและคัดเลือกคลิปไปใช้ในไทม์ไลน์ เครื่องมือที่ส้าคัญคือ 
เครื่องมือเลื่อนภาพ (play / stop / jog / shuttle / previous / next) เครื่องมือก้าหนดจุดเข้า ออก (in point / out 
point) หรือบริเวณที่จะใช้งานจริง เครื่องมือส่งภาพไปลงไทม์ไลน์ (insert / overlay) เป็นต้น ส่วนจอ
โปรแกรม ใช้ดูผลงานการตัดต่อที่เราสร้างขึ้นในซีเควนซ์บนไทม์ไลน์ มีเครื่องมือหลายอย่างคล้ายกับของ
จอซอร์ส ต่างกันที่เคร่ืองมือบนจอโปรแกรม จะท้างานกับซีเควนซ์เท่านั้น 

โครงการที่เปิดท้างานจะมีการบันทึกโดยอัตโนมัติเพื่อป้องกันกรณีระบบเกิดขัดข้องจะได้มีข้อมูล
ส้ารองส่วนหนึ่ง การบันทึกแต่ละครั้งจะกระท้าทุก ๆ 20 นาที และเปลี่ยนชื่อไปเร่ือย ๆ จนครบ 5 ครั้ง หรือ 
5 เวอร์ชันก็จะกลับมาวนรอบใหม่ เราสามารถเปลี่ยนระยะเวลาการบันทึกและจ้านวนเวอร์ชันได้จากค้าสั่ง 
Edit>Preferences>Auto Save  บนแถบเมนู อย่างไรก็ตามทุกครั้งที่มีการแก้ไขโครงการเราจะต้องบันทึก
โครงการเองด้วยค้าสั่ง File>Save  อยู่แล้ว หรือใช้  File>Save As  กรณีที่ต้องการสร้างเป็นไฟล์ใหม่ ส้าหรับ
กรณีที่ระบบเกิดความผิดพลาดหยุดงานก่อนการบันทึก เราสามารถเข้าไปเปิดข้อมูลส้ารองได้ที่โฟลเดอร์ 
My Documents \ Adobe \ Premiere Pro \ 2.0 \ Adobe Premiere Pro Auto-Save จะพบแฟ้มโครงการ
นามสกุล prproj  ที่มีช่ือโครงการเติมต่อท้ายด้วยตัวเลขเวอร์ชัน เช่น MyFirstEdit-1.prproj เป็นต้น 

ข้ันที่ 2 การจับภาพและเสียง 
ภาพและเสียงที่จะน้ามาใช้ในพรีเมียร์ส่วนใหญ่จะอยู่ในรูปของเทปวีดีโอ ยกเว้นกล้องรุ่น ๆ ใหม่ ๆ  

บางรุ่นที่บันทึกวีดีโอลงบนฮาร์ดดิสก์ แผ่นดิสก์ หรือหน่วยความจ้าสามารถถ่ายโอนลงมาใช้งานได้โดยตรง
หากคอมพิวเตอร์มีหน่วยส้าหรับอ่านหรือเขียนต่อกับอุปกรณ์นั้น ส้าหรับในหัวข้อนี้จะกล่าวถึงการจับภาพ
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และเสียงที่อยู่ในรูปของเทปวีดีโอเท่านั้นคอมพิวเตอร์ที่ใช้จับภาพและเสียงจะต้องมีการ์ดจับภาพและเสียง
ติดตั้งพร้อมไดรเวอร์ที่เหมาะสมกับระบบปฏิบัติการนั้น 

นอกจากนี้ยังต้องมีไดรเวอร์ส้าหรับพรีเมียร์โปรอีกด้วย การ์ดไฟร์ไวร์ (FireWire) หรือช่องต่อ 
IEEE 1394 เป็นฮาร์ดแวร์พื้นฐานที่ใช้น้าภาพและเสียงเข้าและออกระหว่างคอมพิวเตอร์และเทประบบ DV 
(digital video) คอมพิวเตอร์โน้ตบุ๊กส์ส่วนใหญ่จะมีช่องต่อไฟ ร์ไวร์ให้อยู่แล้ว ส้าหรับคอมพิวเตอร์ตั้งโต๊ะ
รุ่นประหยัดส่วนใหญ่ไม่มีให้ต้องซ้ือมาติดตั้งเพิ่มเติมซึ่งท่านสามารถเลือกได้ว่าจะใช้เป็นการ์ดไฟร์ไวร์
ธรรมดา หรือเป็นการ์ดตัดต่อวีดีโอโดยเฉพาะ การใช้การ์ดตัดต่อวีดีโอโดยเฉพาะจะมีข้อดีกว่าการใช้ช่องต่อ
ไฟร์ไวร์ปกติอยู่หลายประการเช่น ความสามารถในการน้าภาพและเสียงแบบแอนะล็อกเข้าออกจาก
คอมพิวเตอร์ที่หลากหลาย (composite, s-video, component) ความสามารถในการท้างานที่รวดเร็วแบบเวลา
จริง (realtime) การมีเอฟเฟ็กต์และ ทรานซิชันให้เลือกจ้านวนมาก ตลอดจนความสามารถในการควบคุม
เครื่องเล่นเทปแบบ RS-232/422 เป็นต้น ความสามารถเหล่านี้แตกต่างกันไปตามรุ่นและย่ีห้อของการ์ดตัด
ต่อวีดีโอนั้น ๆ  ถ้าการติดตั้งถูกต้อง ท่านจะพบช่ือของการ์ดตัดต่อในรายการ Device Control ของ 
Preferences เมื่อเรียกจากแถบเมนู Edit กรณีที่มีการ์ดหลายชนิดท่านจะต้องเลือกให้ตรงกับการ์ ดที่ก้าลังจะ
ใช้งานอยู่ในขณะนั้น 

ถ้าสั่ง File>Capture จะเปิดหน้าต่าง Capture ออกมา หากการติดตั้ง ‘เทป ’ หรือ ‘กล้อง ’ กับ
คอมพิวเตอร์ถูกต้อง เราจะเห็นสถานะการท้างานของมันแสดงไว้ด้านบนของกรอบจอภาพเช่น Stop…,  
Paused. , หรือ Play… (ดูรูปที่ 4) ใต้กรอบจอภาพจะมีปุ่มควบคุม (transport control) เลียนแบบเครื่องบันทึก
เทปทั่วไป เราจะสั่งให้เทป Play, Pause, และRecord (หมายถึงการแคปเจอร์) ผ่านปุ่มเหล่านี้ 
ล าดับการ Capture มีดังนี้ 

1. เลือกรูปแบบแฟ้มว่าจะเป็นทั้ง Audio and Video หรือ Audio อย่างใดอย่างหนึ่ง 
2. ตั้งช่ือเทปและช่ือคลิปให้เหมาะสม พรีเมียร์จะเติมตัวเลขล้าดับการบันทึกให้กับช่ือ 

คลิปโดยอัตโนมัติ 
3. ใส่รายละเอียดเพิ่มเติมเช่น Description, Scene, Take ตามความจ้าเป็น 
4. เลือก Scene Detect หากต้องการให้พรีเมียร์แยกแฟ้มให้เมื่อเจอซีนใหม่ 

(ซีนจะตรวจพบท้าคร้ังที่มีการกดบันทึกภาพจากกล้องแต่ละครั้ง) 
5. เลื่อนเทปไปก่อนต้าแหน่งที่ต้องการเร่ิมแคปเจอร์เล็กน้อยแล้วกด Play 
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รูปที่ 4 หน้าต่างการแคปเจอร์ภาพและเสียง 

 
6. กด Record (หรือกด Tape เมื่อควบคุมเครื่องเล่นผ่านเทป Device Control) เมื่อเทปเดินมาถึง

ต้าแหน่งเร่ิมต้นที่ต้องการ กด esc (ที่แป้นพิมพ์ ) หรือ Stop เพื่อหยุดการบันทึก โปรแกรมจะ
แสดงช่ือแฟ้มและช่องใส่ข้อมูลเพิ่มเติม หากมีการเปลี่ยนแปลงใด ๆ ก็กด OK ได้เลย 

7. กรณีแคปเจอร์โดยใช้ Device Control สามารถพิมพ์ด้วยเลขรหัสเวลาเร่ิมต้นและสิ้นสุดลงใน
ช่อง Timecode หรือกดจากปุ่ม Set In,  Set Out เมื่อเทปเดินมาถึงต้าแหน่งที่ต้องการ 

8. กรณีแคปเจอร์ตามต้าแหน่งรหัสเวลา ให้กดปุ่ม In / Out ในกรอบ Capture แทนปุ่ม Record 
หากต้องการแคปเจอร์ทั้งเทป ให้กด Tepe แทน  การแคปเจอร์จะหยุดเองเมื่อภาพหมดหรือเทป
หมด ปุ่ม Tape ยังใช้งานได้เหมือนกับปุ่ม Record เมื่อใช้ Device Control 

9. กรณีที่ต้องการก้าหนดต้าแหน่งเข้าออกไว้ล่วงหน้าหลาย ๆ ชุด เพื่อจะได้สั่งแคปเจอร์ในคร้ัง
เดียว ให้กดปุ่ม Log Clip  เมื่อได้รหัสเวลาเร่ิมต้นและสิ้นสุดของแต่ละชุดแล้ว รายการของ Log 
Clip จะปรากฏในออฟไลน์คลิป (offline clip) ในพาแนล Project เมื่อต้องการแคปเจอร์จริงให้
กดเลือกออฟไลน์คลิปทั้งหมดที่ต้องการแล้วเรียกค้าสั่ง File>Batch Capture พรีเมียร์จะเตือน
ให้เราใส่เทป และท้าการแคปเจอร์คลิปทั้งหมดลงในฮาร์ดดิสก์ในคร้ังเดียว 

1 

2 

3 

4 

5 6 

7 

8 

9 
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การน าเข้า (Import) 
คลิปที่แคปเจอร์แล้วจะถูกน้าเข้า(Import) เป็นคลิปใหม่พาแนล Projectเพื่อน้าไปใช้งานในโครงการ

โดยอัตโนมัติส้าหรับคลิปอื่น ๆ ที่เป็นแฟ้มอยู่ในหน่วยบันทึกข้อมูลอื่นที่มีอัตราการส่งข้อมูลช้าควรจะถ่าย
ลงมาบนฮาร์ดดิสก์ที่ใช้ตัดต่อวีดีโอซึ่งปกติจะมีความเร็วสูงกว่าเสียก่อน การน้าคลิปเข้ามาในโครงการจะใช้
ค้าสั่ง File>Import พรีเมียร์จะให้เราระบุต้าแหน่งและเลือกแฟ้มในโฟลเดอร์ ปุ่ม Ctrl และ Shift จะช่วยเลือก
แฟ้มของวินโดว์ คลิก Import Folder แทน Open หากต้องการน้าเข้าทั้งโฟลเดอร์ 

กรณีของภาพนิ่งหลายภาพที่เรียงเป็นภาพล้าดับ (sequence) แต่ละแฟ้มจะมีตัวแทนล้าดับก้ากับ ให้
คลิก Numbered Stillls เมื่อกด Open พรีเมียร์จะน้าเข้า
แฟ้มทั้งหมดโดยแสดงเป็นชื่อเดียวเพื่อความสะดวก
ในการใช้งาน 

นอกจากการน้าเข้าด้วยค้าสั่งของพรีเมียร์แล้ว 
ยังสามารถใช้วิธีลากมาปล่อย (drop and drop) โดย
ลากมาจาก Windows Explorer มาปล่อยลงในพาแนล 
Project โดยตรง แฟ้มสื่อเฉพาะที่พรีเมียร์รู้จักเท่านั้น
จึงจะเข้ามาในโครงการได้ 

 
 
 
 
รู้จักพาแนล Project 
พาแนล Project ในที่นี้จะเรียกสั้น ๆว่า ‚โครงการ ‛ เพื่อความสะดวก พาแนลนี้แบ่งพ้ืนที่เป็นสอง

ส่วนคือ ส่วนพรีวิว (preview area)  ซึ่งอยู่ตอนบน ใช้ส้าหรับเปิดลองคลิปที่เลือกไว้ในรายการข้างล่าง การ
เปิดลองคลิป  นอกจากจะกดปุ่มสามเหลี่ยม Play  ข้างจอพรีวิวแล้วยังใช้แถบเลื่อนด้านใต้เพื่อไปยังต้าแหน่ง
ต่าง ๆ ด้วยความรวดเร็วอีกด้วย ประโยชน์ที่แท้จริงในการเปิดลองคลิปบนพาแนลนี้ก็คือการเปลี่ยนตัวแทน
ย่อ (thumbnail) ของคลิปที่แสดงบนพรีเมียร์ โดยปกติพรีเมียร์จะใช้เฟรมแรกแสดงเป็นตัวแทนย่อของคลิป
นั้นแต่กรณีที่คลิปที่นั้นขึ้นต้นด้วยภาพที่ไม่สื่อความหมายเช่น ภาพมืด หรือรูปสเ ลต เหมือนกันหมด จะท้า
ให้ผู้ใช้สับสนได้ เราจะเลื่อนไปหาต้าแหน่งใหม่ที่ภาพมีความหมายกว่าจากนั้นให้กดปุ่ม Poster Frame ซึ่ง
เป็นรูปกล้องถ่ายรูปข้างจอพรวิว ภาพใหม่นี้จะกลายเป็นตัวแทนย่อของคลิปนั้นในการใช้งานบนพรีเมียร์
ต่อไป กรณีที่ไม่ต้องการใช้งานพื้นที่ในส่วนนี้แล้วก็สามารถปิดได้โดยคลิกปลดเครื่องหมายถูกหน้ารายการ 
Preview ของค้าสั่ง View บน ‘ปุ่มค้าสั่งพาแนล’ (สามเหลี่ยมมุมบนขวาของแต่ละพาแนล) 

รูปที่ 5 แสดงหน้าต่าง Import 



16 

 

พื้นที่ส่วนที่สองถัดจากส่วนพรีวิวลงมาเป็นช่องแสดงรายการ บริเวณกรอบล่างใช้วางเครื่องมือที่ใช้
บ่อยแทนการเรียกจาก ‘ปุ่มค้าสั่งพาแนล’ ข้างต้น เครื่องมือเหล่านี้เรียงล้าดับจากซ้ายคือ 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. List View  2. Icon View  3. Automate to Sequence  4. Find  5. Bin  6. New Item  7. Clear 
รูปที่ 6 พาแนล Project 

 
1. ปุ่มแสดงรายการแบบแถว (list)ใช้แสดงคลิปในรายการเป็นแถวยาว   เร่ิมต้นด้วยสัญรูป บอก 

ประเภทรายการ (หรือเป็นตัวแทนย่อหากรายการ Thumbnails บนปุ่มค้าสั่งพาแนล ไม่ได้ถูก Off ไว้) ตาม
ด้วย ช่ือและ คุณสมบัติ (attribute) อื่น ๆ การดูคุณสมบัติทั้งหมดอาจจะต้องใช้แถบเลื่อนด้านล่างพร้อมกับ
ขยายพาแนลเข้าช่วย เราสามารถเปิดปิดช่องแสดงคุณสมบัติเหล่านี้จากค้าสั่ง Edit Column บนปุ่มค้าสั่ง
พาแนลนอกจากนี้ยังเรียงล้าดับ (sort) รายการได้โดยคลิกไปที่ช่ือคุณสมบัติของคลิปที่ต้องการใช้เป็นกุญแจ 
(key)  ในการเรียงล้าดับบริเวณส่วนหัวของคอลัมน์นั้น สัญญลักษณ์หมวกคว่้า ‘^’ หรือหงาย ‘v’ หลังช่ือ
คุณสมบัติจะบอกถึงการล้าดับว่าเป็นแบบมากไปหาน้อยหรือน้อยไปหามาก 

2. ปุ่มแสดงรายการเป็นสัญลักษณ์รูป (icon)  เพื่อให้มองเห็นคลิปในรายการเป็น ตัวแทนย่อ  
(thumbnail)  กรณีคลิปภาพหรือวีดีโอโดยไม่ต้องแสดงคุณสมบัติอื่นยกเว้นชื่อซึ่งจะมีก้ากับอยู่แล้ว เรา
สามารถเปลี่ยนขนาดของตัวแทนย่อได้สามระดับจากรายการ Thumbnails บน ‘ปุ่มค้าสั่งพาแนล ’ ค้าสั่งนี้
นอกจากจะเปลี่ยนขนาดของตัวแทนย่อในการแสดงรายการเป็นสัญลักษณ์รูปแล้วยังใช้เปลี่ยนขนาดของสัญ
รูปและตัวแทนย่อเมื่อแสดงเป็นแบบแถวรายการได้อีกด้วย  (แต่ขนาดของสัญลักษณ์รูปและตัวแทนย่อใน

Panel command button 

1 2 3 4 5 6 7 

List of ASsets 
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การแสดงแบบแถวรายการจะเล็กกว่า )  คุณสมบัติพิเศษเมื่อแสดงรายการแบบสัญรูปก็คือเราสามารถคลิก
ลากเพื่อจัดกลุ่มและย้ายล้าดับรายการเหล่านี้ได้อย่างอิสระ เพื่อใช้เป็นสตอรีบอร์ด (storyboard) ตามบทเร่ือง
นั่นเอง   เราสามารถส่งคลิปเหล่านี้ไปเรียงเป็นซีเควนซ์ตามล้าดับที่จัดไว้บนไทม์ไลน์ 

3.  ปุ่มจัดซีเควนส์อัตโนมัติ (auto-mate to sequence) ใช้ส่งคลิปที่เลือกไว้ในโปรเจ็กต์ลงไปวางใน
ซีเควนส์โดยอัตโนมัติ 
             4.   ปุ่มค้นหา (find) เมื่อทราบคุณสมบัติใดคุณสมบัติหนึ่งของคลิป    เช่นชื่อ ชนิด หรือความยาวให้
กดปุ่มค้นหาแล้วน้าคุณสมบัติหนึ่ง หรือสองข้อไปกรอกเป็นข้อมูลส้าหรับการค้นหาคลิปที่อยู่ในโปรเจ็กต์
ได้ 

5.  ปุ่มสร้างบิน (bin) บินหรือลิ้นชักย่อย สร้างขึ้นเพื่อใช้เก็บคลิปและซีเควนซ์ที่อยู่ในโครงการให้
เป็นหมวดหมู่ เปรียบได้กับการสร้างโฟลเดอร์เพื่อจัดกลุ่มแฟ้มข้อมูลหรือโปรแกรมต่าง ๆ บนฮาร์ดดิสก์การ
น้าคลิปเข้าออกบินก็คล้ายกับการจัดแฟ้มข้อมูลในโฟลเดอร์ คือสามารถลากมาปล่อย ลบทิ้ง หรือสร้างบิน
ซ้อนบินลงไปหลาย ๆ ช้ัน เราสามารถน้าเข้าอัตถสารลงไปในบินได้โดยตรงเมื่อคลิกเลือกบินก่อนการส่ัง
น้าเข้า 

6.  ปุ่มสร้างรายการใหม่ (new item) ค้าว่ารายการในที่นี้คือรายการที่สร้างขึ้นโดยพรีเมียร์ เช่น        
ซีเควนซ์ ไตเติ้ล แถบสีทดสอบ และคลิปนับถอยหลัง (count down) เป็นต้น 

7.  ถังขยะ (clear) ใช้ล้างหรือลบรายการออกจากโครงการ โดยคลิกเลือกรายการที่ต้องการลบแล้ว
จึงกดปุ่มถังขยะนี้ อาจใช้วิธีลากรายการมาทิ้งในถังขยะเหมือนกับการท้างานในวินโดว์ปกติได้เช่นกัน 

หลังจากน้าแฟ้มทั้งหลายเข้ามาเป็นคลิปในโครงการแล้วกระบวนการตัดต่อวีดีโอจึงจะเร่ิมได้ดังจะ
อธิบายในล้าดับต่อ ๆ ไป อย่างไรก็ตามรายการที่อยู่ในโครงการอาจจะไม่ใช่คลิปก็ได้เช่น ซีเควนซ์ ถึงแม้ตัว
มันโดด ๆ จะใช้งานได้เหมือนคลิป แต่ปกติจะไม่มีใครเรียก ซีเควนซ์ ว่าเป็น คลิป หรือ คลิปซีเควนซ์ 
 

ข้ันที่ 3 การประกอบและจัดซีเควนซ์ 
ซีเควนซ์ถือเป็นคลิปหนึ่งที่อยู่บนพาแนล Project ทุกครั้งที่มีการเปิดโครงการใหม่พรีเมียร์จะสร้าง

ซีเควนซ์ช่ือ Sequence 01 ให้โดยอัตโนมัติ ซีเควนซ์ประกอบด้วยลู่ภาพและเสียง การวางคลิป การใส่  ทราน
ซิชันและเอฟเฟ็กต์ให้กับคลิปบนซีเควนซ์ จะกระท้าบนไทม์ไลน์เท่านั้น  เราสามารถเปิดซีเควนซ์ได้พร้อม
กันหลายซีเควนซ์ และยังน้าซีเควนซ์หนึ่งไปวางไว้ในอีซีเควนซ์ห นึ่ง  (nested sequences)  ในลักษณะ
เหมือนกับคลิปวีดีโออันหนึ่งได้  การสร้างซีเควนซ์ใหม่สามารถเรียกจากเครื่องมือ New Item ในพาแนล  
Project  หรือจาก  File>New>Sequence บนแถบเมนู ค้าสั่ง Rename ที่ได้จากการคลิกขวาที่รายการซีเควนซ์
ในโครงการจะใช้แก้ไขหรือเปลี่ยนชื่อซีเควนซ์ที่มีอยู่ได้แล้ว 
 

พาแนล Timeline 
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ก่อนที่จะลงมือประกอบคลิปให้เป็นซีเควนซ์ในไทม์ไลน์ เรามาท้าความรู้จักกับส่วนต่าง ๆของ 
ไทม์ไลน์ที่จ้าเป็นต่อการท้างานเบื้องต้นกันเสียก่อน รายละเอียดที่เหลือจะน้ามาเสริมให้เมื่อถึงตอนที่
เกี่ยวข้อง เพื่อความสะดวก ต่อไปจะเรียกพาแนล Timeline สั้น ๆ ว่า ‚ไทม์ไลน‛์ 
 

 
 

รูปท่ี 7  พาแนล Timeline 

 
เร่ิมจากต้าแหน่งบนสุดของ จะบอกช่ือของพาแนล นั่นคือ Timeline: ต่อด้วยช่ือของซีเควนซ์ ซึ่งใน

ที่นี้ก็คือ Sequence 01 ใต้ช่ือจะเป็นตัวเลขรหัสเวลา (timecode) บอกต้าแหน่งที่ เข็มแสดงเวลาปัจจุบัน 
(current time indicator) ช้ีอยู่ ด้านขวาของรหัสเวลาจะเป็นบรรทัดเวลา เมื่อคลิกไปที่บริเวณนี้เข็มช้ีเวลา
ปัจจุบันจะวิ่งมายังจุดที่คลิกทันที หากเข็มช้ีตั้งเวลาพาดอยู่บนคลิปภาพ ภาพที่จุดนั้น (หากลู่ไม่ถูกปิดเอาต์
พุดไว้) ก็จะไปปรากฏบนจอโปรแกรม (program monitor) ด้วย การพลิกแล้วลากเมาส์ไปมาบนบรรทัดเวลา
เพื่อให้ภาพไปปรากฏบนจอโปรแกรมเรียกว่าการสครับ (scrub) ต้าแหน่งของเข็มช้ีเวลาบนไทม์ไลน์กับเข็ม
ช้ีเวลาในจอโปรแกรมนั้นคือต้าแหน่งเดียวกัน การโยกย้ายเข็มช้ีที่ตัวใดตัวหนึ่งจะเกิดผลกับอีกทีหนึ่ง
เช่นเดียวกัน 
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รูปที่ 8 แสดงรายละเอียดส่วนหัวของไทม์ไลน์ 

 
พื้นที่ส่วนล่างจะเป็นลู่ภาพและเสียงปกติจะเร่ิมต้นด้วยลู่วีดีโอหรือลู่ภาพ 3 ลู่และลู่เสียงแบบสเตอ  

ริโออีก 3 ลู่ ลู่หมายเลข 1 ทั้งของภาพและเสียงปกติจะถูกขยายไว้เพื่อให้คลิปและเครื่องมือท้างานมี
รายละเอียดมากกว่าปกติ  อย่างไรก็ตามเราสามารถสั่งปิดหรือเปิดการขยายเองได้ทุกลู่ตามต้องการ ภาพของ
ลู่วีดิโอที่อยู่บนด้านบนหรือที่มีตัวเลขมากกว่าจะบังภาพของลู่ที่อยู่ด้านล่างเสมอ บริเวณหัวลู่จะมีปุ่มและ
ช่องส้าหรับจัดรูปแบบของแต่ละลู่ เช่นปุ่มพับ /ขยายปิดการขยายลู่ (รูปสามเหลี่ยม ), ช่องล็อกลู่ไม่ให้มีการ
แก้ไขงานที่อยู่บนลู่นั้น, และช่องปิดเปิดเอาต์พุดเพื่อก้าหนดให้ภาพบนลู่นั้นไปปรากฏทางเอาต์พุด หรือไม่ 
เป็นต้น 

กรอบด้านขวาและกรอบด้านล่างจะเป็นแถบเลื่อนส้าหรับแสดงลู่หรือส่วนของลู่ที่อยู่นอกกรอบ 
นอกจากนี้ยังมีปุ่มซูมเข้า / ออกและแถบเลื่อนซูม เพื่อย่อขยายซีแควนซ์ให้ท้างานได้สะดวก 

การวางคลิปบนไทม์ไลน์งานหลักของการตัดต่อวีดีโอจะเร่ิมตั้งแต่การน้าคลิปจากพาแนล Project 
ส่งไปประกอบเป็นซีเควนซ์บนไทม์ไลน์  วิธีที่ง่ายที่สุดและมักใช้สาธิตการท้างานตัดต่อเบื้องต้นก็คือ การ
คลิกลากคลิปจากพาแนล Project หรือจากจอซอร์ส (source monitor) มาวางบนไทม์ไลน์ คลิปที่ลากมาอาจ
เป็นเพียงคลิปเดียว หรือ หลายคลิปพร้อมกัน หากมีคลิปหายคลิปถูกเลือกไว้ก่อนหน้านี้ ปกติคลิปเหล่านี้จะ
ถูกลากมาวางอยู่บนลู่ Videoในการวางอาจวางตั้งแต่หัวลู่ คือต้าแหน่งรหัสเวลาที่ 00-00-00-0 หรืออาจขยับ
เลื่อนออกมาเล็กน้อยส้าหรับเผ่ือการปรับแต่งเล็ก ๆ น้อย ๆในอนาคต คลิปภาพทีเป็นวีดีโอที่มีเสียงติดมา
ด้วยก็จะแยกส่วนของเสียงไปลงลู่เสียงหมายเลขเดียวกันยกเว้นกรณีที่ส่วนของเสียงนั้นมีจ้านวนช่องเสียง 
(mono, stereo, หรือ 5.1ช่อง) ไม่ตรงกับช่องเสียงในลู่นั้น พรีเมียร์จะน้าเสียงไปวางบนลู่ที่มีจ้านวนช่องเสียง
เท่ากันซึ่งอาจเป็นลู่ที่มีหมายเลขต่างกับส่วนของภาพ กรณีที่ไม่มีลู่เสียงที่มีจ้านวนช่องเสียงตรงกัน พรีเมียร์
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จะสร้างลู่เสียงใหม่ที่สอดคล้องกันให้อัตโนมัติปกติแท่งคลิปวีดีโอที่วางลงไปบนไทม์ไลน์ พรีเมียร์จะให้
ส่วนหัวของแท่งคลิปแสดงภาพแรกของวีดีโอคลิปนั้น (หรือภาพที่เราก้าหนดให้เป็น Poster frame) แต่เรา
สามารถปรับเปลี่ยนวิธีการแสดงเสียใหม่ได้โดยการคลิกปุ่มเลือกสไตล์ (Set Display Style) ใต้ช่องปิดเปิด  
Output ที่กล่าวมาแล้วซึ่งมีทางเลือกได้สี่วิธีคือ ให้แสดงเฉพาะภาพแรกและภาพสุดท้ายของคลิป (Show 
Head and Tail ), แสดงเป็นภาพเรียงตลอดคลิปอย่างเดียว (Show Name Only) เช่นเดียวกับลู่เสียง ปุ่มเลือก
สไตล์จะให้เลือกแสดงแท่งเสียงเป็นรูคลื่นเสียง (Show Waveform) หรือเฉพาะช่ือคลิปอย่างเดียวได้เช่นกัน
คลิปที่น้ามาวางต่อกันบนไทม์ไลน์อาจมีส่วนที่ไม่ต้องการติดอยู่โดยเฉพาะที่ส่วนหัวและท้ายคลิป เรา
จะต้องมีการปรับเล็ม(trim)  ทิ้งไป โดยคลิกไปที่เครื่องมือเลือก(selection tool) บนกล่องเครื่องมือ (รูปลูกศร
ช้ีขึ้น   หรือกดอักษร ‚V‛ บนแป้นพิมพ)์เมื่อเลื่อนตัวช้ีไปยังบริเวณหัวหรือท้ายแท่งคลิป ตัวช้ีเปลี่ยนเป็นสัญ
รูปทริมอิน (trim-in) หรือ ทริมเอาต์ (trim-out)   จากนั้นก็คลิกลากเพื่อหดแท่งคลิปให้สั้นลง ในขณะลาก
ภาพที่ต้าแหน่งนับจะปรากฏบนจอโปรแกรม(program monitor)  เพื่อให้เราเลือกจุดที่ต้องการได้สะดวกจุด
ที่เราหดแท่งคลิปทางส่วนหัวเข้ามาพรีเมียร์จะเรียกว่าจุดเข้า (in point) ส่วนจุดที่เราหดแท่งคลิปทาง
ส่วนท้ายเข้ามาเรียกว่าจุดออก (out point) ช่วงระหว่างจุดเข้ากับจุดออกเป็นช่วงของคลิปที่เราต้องการ
น้ามาใช้งานจริง ๆ กรณีคลิปที่ไม่ได้ถูกปรับเล็มเลยจุดเข้าเข้าและจุดออกจะอยู่ที่ต้นคลิปและท้ายคลิปพอดี 
การก้าหนดจุดเข้าออกนอกจากจะได้ช่วงของคลิปตามที่ต้องการแล้วส่วนที่เหลือระหว่างจุดเข้าออกกับส่วน
ปลายทั้งสองข้างแท่งคลิปซึ่งเรียกว่าพื้นที่ปรับเล็ม (trim area) ยังใช้ส้าหรับการวางทรานซิชันระหว่างคลิป
อีกด้วย 

 
ส่งคลิปจากจอซอร์ส 
พบว่าการคลิกลากคลิปจากพาแนลProject มาวางบนไทม์ไลน์ดังกล่าวเป็นวิธีที่เข้าใจง่าย จึงเป็นที่

นิยมส้าหรับผู้ฝึกพรีเมียร์ใหม่ ๆ และมักถูกน้าไปสาธิตการท้างานตัดต่อวีดีโอจริงนั้น  คลิปทั้งหมดจะต้องมี
การตัดซอยเป็นคลิปย่อย (subclip) และปรับเล็มก่อนทุกครั้ง นอกจากนั้นยังต้องตรวจดูความสัมพันธ์
ระหว่างคลิปที่จะน้ามาต่อกับคลิปที่วางไว้แล้วอีกด้วย ดังนั้นในการท้างานจริงนักตัดต่อจะนิยมส่งคลิปเข้าสู่
จอซอร์ส (source monitor) ซึ่งเป็นจอที่อยู่ทางซ้ายก่อน เพื่อก้าหนดจุเข้าออกก่อนแล้วจึงส่งลงไปบนไทม์
ไลน์ 

การน้าคลิปเข้าสู่ซอร์สใช้วิธีกดคลิกคลิกที่คลิปนั้นบนพาแนล Project หรืออาจคลิกลากมาปล่อยลง
บนจอซอร์สก็ได้กรณีที่มีคลิปหลายคลิปอยู่ในจอซอร์สพร้อมกับเราสามารถเลือกท้างานกับแต่ละคลิปได้
โดยคลิกสามเหลี่ยมหน้าช่ือคลิปบริเวณกรอบบนของจอซอร์ส รายช่ือของคลิปทั้งหมดที่อยู่ในจอซอร์สก็จะ
แสดงออกมาให้เราเลือกรายการที่มีเครื่องหมายถูกน้าหน้าแสดงถึงคลิปปัจจุบันที่เปิดอยู่ เรายังสามารถปิด
คลิปที่เปิดอยู่โดยเลือกรายการค้าสั่ง Close หรือปิดคลิปทั้งหมดเพื่อล้างจอซอร์สโดยค้าสั่ง Close All ก็ได้ 
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รูปที่ 9 การเลือกคลิปบนจอซอร์ส 
 

บนจอซอร์สจะมีเครื่องมือควบคุมการท้างานจ้านวนหนึ่ง การเลือกจุข้าวของคลิปเร่ิมจากการเลื่อน
ภาพไปดูส่วนต่าง ๆ โดยใช้ปุ่มเล่น (play)    บนจอ  (หรือกด  space bar),ใช้แถบเลื่อน Jog หรือ  Shuttle, 
การเลื่อนแบบเดินหน้าที่ละเฟรม (step  backward)  หรือกดลูกศรเลื่อนขวาบนแป้นพิมพ์ ,ถอยหลังทีละ

เฟรม  (step backward)   หรือกดลูกศรเลื่อนซ้ายบนแป้นพิมพ์, หรือการเลื่อนอย่างรวดเร็วโดยใช้เข็มช้ี
ต้าแหน่งเวลาปัจจุบัน (current-time indicator)   ซึ่งจะแสดงต้าแหน่งรหัสเวลาในขณะนั้นไว้ที่ใต้ภาพที่
ต้องการแล้วให้กดปุ่ม ต้ังจุดเข้า (setIn point)   รูปปีกกาเปิด หรือกดอักษร I บนแป้นพิมพ์ ท้านอง
เดียวกันกับการต้ังจุดออก หลังจากเลื่อนภาพไปยังต้าแหน่งที่ต้องการแล้วให้กดปุ่ม ต้ังจุดออก (set  out 

point)   รูปปีกกาปิด หรือกดอักษร  O บนแป้นพิมพ์ แถบสีเทาปิดด้วยปีกกาบนแถบเวลาของจอซอร์ส
เพื่อแดดงถึงช่วงคลิประหว่างจุดเข้าและจุดออกก็จะปรากฏขึ้นพร้อมกับตัวเลขบอกความยาวในรูปของรหัส
เวลาไว้ที่ใต้ภาพด้านขวาเช่นกัน เราสามารถเปิดเล่นคลิปเพื่อตรวจสอบเฉพาะในช่วงนี้ด้วยปุ่มเล่นช่วงเข้า
ออก (play in to out)  นอกจากนี้ยังก้าหนดให้การเล่นเป็นแบบวนซ้้าด้วยการกด ปุ่มวน (loop)   ให้
ท้างานเมื่อมีการก้าหนดจุเข้าและจุดออกของคลิปแล้ว เราสามารถกระโดดไปยังจุดทั้งสองนี้อย่างรวดเร็วได้
โดยการก ดปุ่ม ไปที่จุดเข้า (go in point)  หรือ กดอักษร C บนแป้นพิมพ์ และไปที่จุดออก (go out 
Point)    หรือกดอักษร  W  บนแป้นพิมพ์  นอกจากนั้นยังมีปุ่มที่ใช้แสดงพ้ืนที่ปลอดภัยจากตกกรอบ 
(safe Margins)  และปุ่มแสดงเอาต์พุด (output)   แบบต่าง ๆ ซ่ึงจะได้กล่าวโดยละเอียดต่อไป 
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เมื่อคลิปพร้อมที่จะส่งลงไปบนไทม์ไลน์อันดับแรกต้องเลือกลู่ซึ่งจะวางก่อนโดยคลิกไปที่บริเวณ
ว่าง ๆ ที่ส่วนหัวของลู่ Video  และ  Audio  (ถ้ามี)  หมายเลขที่ต้องการ หัวลู่จะเปลี่ยนสีจากเทาเป็นสีสว่าง
หรือขาวขึ้นเพื่อบอกเราว่าลู่นี้ถูกเลือกเอาไว้แล้ว จากนั้นให้เลือกว่าจะส่งทั้งภาพเละเสียง  หรือเฉพาะภาพ
หรือเสียง  โดยกดปุ่มเลือกสลับประเภท (toggle take audioAnd video)  ที่อยู่ใต้ปุ่มแสดงเอาต์พุด สัญลักษณ์
ของปุ่มจะเปลี่ยนวนจากรูปฟิล์มกับล้าโพง  เป็นฟิล์มอย่างเดียว หรือ ล้าโพงอย่างเดียวเส้นสีแดงพาดลู่
ทั้งหมดทางแนวตั้งที่มีหัวเป็นเข็มช้ีเวลาปัจจุบันบนไทม์ไลน์ จะใช้เป็นจุดก้าหนดต้าแหน่งการวางคลิป เมื่อ
คลิกที่ต้าแหน่งใด ๆ บริเวณบรรทัดเวลาซึ่งอยู่บนสุดของไทม์ไลน์  เข็มช้ีเวลาปัจจุบันของไทม์ไลน์ก็จะ
ปรากฏขึ้นที่จุดนั้น  คลิกลากเข็มช้ีเวลานี้ไปยังต้าแหน่งที่ต้องการวางคลิปหรือใช้ปุ่มควบคุมการเล่นบนจอ
โปรแกรมซึ่งจะท้างานแบบเดียวกันกับปุ่มบนจอซอร์สเข้าช่วย  การท้างานกับปุ่มเหล่านี้จะส่งผลไปที่     
ไทม์ไลน์โดยตรง กรณีที่มีคลิปบางส่วนอยู่บนไทม์ไลน์อยู่แล้ว  การใช้ปุ่มลัดต่อไปนี้จะช่วยให้ท่านท้างาน
บนไทม์ไลน์ได้อย่างมีประสิทธิภาพ 

1. ปุ่ม Back Slash ‘\’ ใช้ส้าหรับซูมไทม์ไลน์ออกให้ทุกคลิปที่อยู่บนไทม์ไลน์มองเห็นได้หมดใน
จอเดียว การมองเห็นคลิปทั้งหมด จะช่วยให้ท่านรู้ต้าแหน่งปัจจุบันและไปยังต้าแหน่งใหม่ได้ง่ายย่ิงขึ้น 

2.  ปุ่ม  ‘=’   และ  ‘_’  ใช้ซูมไทม์ไลน์เข้าหรือออกทีละหนึ่งระดับ ช่วยให้การจัดการกับคลิปได้
สะดวกย่ิงขึ้น ปกติปุ่ม ‘=’  จะอยู่ที่เดียวกับปุ่ม ‘+’  เพื่อให้มีนัยของความตรงกันข้าม  บางครั้งจึงเรียกเป็น
ปุ่ม ‘+’ และปุ่ม  ‘_’  แทน 

3.  ปุ่ม Pg Up, Pg Dn  ใช้ส้าหรับเลื่อนเข็มช้ีเวลาปัจจุบันวิ่งไปยังจุดตัดต่อซึ่งปกติก็คือรอยต่อ
ระหว่างคลิปต่าง ๆ  หรือส่วนหัวคลิปหากเป็นคลิปแรก  และว่ิงไปต่อท้ายคลิปหากเป็นคลิปสุดท้าย 

4. ปุ่ม  Home  ใช้ส้าหรับให้เข็มช้ีเวลาปัจจุบันวิ่งไปยังต้นไทม์ไลน์ หรือต้าแหน่งที่  00:00:00:00 
5. ปุ่ม  End  ใช้ส้าหรับว่ิงไปต่อท้ายคลิปสุดท้ายที่วางอยู่บนไทม์ไลน์ 
6.  ปุ่ม  Space Bar  ใช้แทนปุ่ม Play /Stop  บนจอซอร์ส หรือจอโปรแกรมขึ้นอยู่ในขณะนั้นจอใด

ท้างานอยู่  กรณีท้างานอยู่บนไทม์ไลน์  การท้างานจะเป็นเช่นเดียวกับการท้างานอยู่บนโปรแกรม นั่นก็คือ
การส่ังให้เล่นหรือหยุดการพรีวิวซีเควนซ์บนไทม์ไลน์ โดยมีภาพแสดงทางจอโปรแกรมนั่นเอง 

7.  ปุ่มคอมม่า ‘,’ และจุด ‘ . ’  ใช้ส้าหรับ ส่งคลิปจากซอร์สลงบนไทม์ไลน์ดังจะกล่าวต่อไป 
การวางคลิปแบบแทรก (Insert Edit) 
เมื่อเข็มช้ีเวลาปัจจุบันชี้ต้าแหน่งที่ต้องการแล้ว เราสามารถส่งคลิปจากจอซอร์สลงไปแทรก (insert)  

ที่ต้าแหน่งนั้นโดยการกดปุ่มวางแทรก    บนจอซอร์ส  หรือกดปุ่ม ‘คอมม่า’  บนแป้นพิมพ์ เมื่อต้องการ
ดันคลิปหรือช่องว่างที่ต้าแหน่งปัจจุบันออกไปก่อนที่จะวางคลิปใหม่ลง กรณีที่ต้าแหน่งปัจจุบันอยู่ในส่วน
ของคลิปใดคลิปหนึ่งบนลู่ที่เลือกไว้ คลิปนั้นจะถูกแยกออกเป็นสองส่วนไปด้วย  การดันคลิปออกไปจะมี
ผลกับทุกลู่ที่ไม่ได้เลือกไว้  นั้นคือจะเกิดช่องว่างเท่ากับความยาวของคลิปที่แทรกเข้ามา  กรณีที่ต้องการให้
การแทรกมีผลเฉพาะลู่ที่เลือกไว้เท่านั้น ให้กดปุ่ม  Alt พร้อมกับการส่ังแทรกคลิป 

การวางคลิปแบบทับ  (Overlay Edit) 



23 

 

ในบางกรณีเราอาจต้องการทับคลิปหรือช่องว่างบริเวณนั้นด้วยคลิปใหม่โดยไม่ต้องร่นสิ่งที่อยู่ข้าง
หลังออกไป เรียกว่าการวางทับ (overlay)  กรณีนี้ให้กดปุ่มวางทับ   หรือกดปุ่ม ‘จุด’บนแป้นพิมพ์ การ
ลากกดคลิปจากพาแนล Project หรือ จากจอซอร์สมาวางยังต้าแหน่งใด ๆ บนไทม์ไลน์โดยตรงดังกล่าว
มาแล้วในหัวข้อก่อนหน้านี้ จะมีลักษณะเป็นแบบวางทับเช่นเดียวกัน กรณีที่ต้องการให้การปล่อยคลิปเป็น
แบบวางแทรก ต้องกด Ctrl  ก่อนการดึงมาปล่อย หรือกด Alt อีกปุ่มหนึ่งเมื่อต้องการให้มีผลเฉพาะลู่เดียว
เช่นกัน กรณีที่เข็มช้ีต้าแหน่งอยู่ในต้าแหน่งต่อท้ายคลิปสุดท้ายของซีเควนซ์  การวางแทรกหรือวางทับจะไม่
มีความแตกต่างกัน เมื่อวางคลิปเสร็จเข็มช้ีเวลาปัจจุบันจะเลื่อนไปต่อท้ายคลิปที่วางเสร็จเพื่อเป็นการเตรียม
ส้าหรับการน้าคลิปต่อไปมาวางต่อนั่นเอง 

การวางหลายคลิปพร้อมกัน 
 แบบ Automate 

 ถึงแม้เราสามารถลากคลิปที่ถูกเลือกไว้พลาย ๆ คลิปมาวางบนไทม์ไลน์ได้โดยตรงดังกล่าว
มาแล้ว แต่การวางคลิปโดยตรงยังมีข้อจ้ากัดหลายอย่าง ที่ส้าคัญที่สุดคือไม่สามารถล้าดับต้าแหน่ง
ก่อนหลังได้พรีเมียร์ได้หาทางแก้ไว้แล้วโดยค้าสั่ง Automate to Sequence บนเมนูค้าสั่ง Project 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

รูปที่ 10 หน้าต่างก้าหนดรายละเอียดของการวางคลิปแบบอัตโนมัต ิ
 
 
ค้าสั่งนี้จะท้างานได้ต่อเมื่อมีคลิปอย่างน้อยหนี่งคลิปบนพาแนล Project ถูกเลือกไว้ จากหน้าต่า ง

สนทนาเมื่อเรียกใช้ค้าสั่งนี้จะเห็นว่า ในหัวข้อ Ordering เราสามารถเลือกได้ว่าจะให้เรียงคลิปตามที่ล้าดับไว้ 
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(sort order) (กรณีแสดงรายการเป็นสัญรูปจะนับเรียงจากซ้ายไปขวาและจากบนลงล่าง ) หรือตามล้าดับการ
กดเลือกคลิปในโปรเจกต์ (selection order) นอกจากนั้นยังก้าหนดต้าแหน่งการวางคลิปว่าจะให้เรียงติดกัน 
(sequentially) เร่ิมจากต้าแหน่งที่เข็มช้ีเวลาปัจจุบันพอดีหรือเลื่อนออกไปยังต้าแหน่งต่อไปที่พบเครื่องหมาย
(marker) แบบไม่มีตัวเลขก้ากับ (unnumbered)  หากทีการสร้างเครื่องหมายนี้บนไทม์ไลน์ไว้ล่วงหน้า กรณี
ที่เครื่องหมายแบบไม่มีตัวเลขก้ากับมีหลายตัว พรีเมียร์จะท้าการจับคู่เรียงเข้ากับล้าดับของคลิปที่จะน้ามา
วาง  นั่นหมายความว่าคลิปอาจจะไม่วางติดต่อกันขึ้นอยู่กับระยะห่างของต้าแหน่งเครื่องหมายฯ เหล่านั้น 

 กรณีที่เครื่องหมายฯมีจ้านวนน้อยกว่าจ้านวนคลิป คลิปที่เหลือที่ไม่มีคู่จับจะวางเรียงชิดกัน
ตามล้าดับที่เลือกไว้ ลักษณะการวางคลิปยังก้าหนดได้จากหัวข้อ Method ว่าจะให้เป็นแบบวางซ้อนหรือวาง
ทับ นอกจากนั้น กรณีที่เลือกการวางแบบเรียงติดกัน เราสามารถน้าทรานซิชันที่ถูกเลือกให้เป็นค่าโดย
ปริยาย (default) มาใส่ให้กับช่วงต่อของคลิปที่จะน้ามาวางลงทั้งหมดได้อีกด้วย 

การปรับคลิปบนไทม์ไลน์ 
ถึงแม้จะเลือกจุดเข้าออกของแต่ละคลิปมาแล้วอย่างดี แต่เมื่อน้าลงสู่ไทม์ไลน์แล้วเราอาจจะต้องมี

การปรับแต่งแก้ไขอีกครั้งด้วยเหตุผลที่เป็นไปได้หลายประการเช่น  การสร้างความสอดคล้องของการแสดง 
(Matching action) การแทรกภาพเพื่อตอบสนองการแสดง ( reaction shot) การปรับจังหวะเวลาของคลิ ป 
และ การสร้างความราบรื่นให้กับการแสดง (continuity) เป็นต้นนอกจากการปรับทริมคลิปโดยใช้เครื่องมือ
เลือกวัตถุเพื่อปรับต้าแหน่งจุดเข้าจุดออกใหม่ที่กล่าวไว้ในหัวข้อการลากคลิปมาวางบนไทม์ไลน์แล้วยังมี
ทางเลือกที่ให้ความสะดวกกว่าอีกหลาย ๆ แบบ ดังนี้ 

1. การส่งคลิปในไทม์ไลน์ไปปรับจุดเข้าออกบนซอร์ส :  เนื่องจากไทม์ไลน์ไม่ได้ออกแบบให้ใช้
ในการปรับจุดเข้าออกโดยตรงจึงมีความสะดวกสู้การปรับบนจอซอร์สไม่ได้  คลิปจะถูกส่งเข้าจอซอร์สทัน
ที่เมื่อกดคลิกคลิกไปที่คลิปบนไทม์ไลน์  การเลื่อนจุดเข้าออกบนจอซอร์สจะส่งผลไปที่แห่งคลิปบนไทม์
ไลน์ทันที  อย่างไรก็ตามการขยายจุดเข้าออกอาจท้าไม่ได้หากมีคลิปอื่น ไปกั้นไว้จุดเด่นของการปรับจุดเข้า
ออกบนจอซอร์สที่ส่งขึ้นไปจากไทม์ไลน์ก็คือ  กรณีที่เราต้องการรักษาความยาวหรือระยะเวลาระหว่างจุด
เข้าและจุดออกไว้ การคลิกไปที่มือจับ  (grip)  ซึ่งอยู่ที่กึ่งกลางของแถบสีเทาบอกช่วงของจุดเข้าออกนั้นจะ
ท้าให้เราเห็นภาพทั้งสองต้าแหน่งได้พร้อมกัน  การเลื่อนที่มือจับจะเปลี่ยนต้าแหน่งของจุดเข้าและจุด
ออกไปพร้อมกันโดยจะรักษาเวลาในช่วงเข้าออกของคลิปนั้นไม่ให้เปลี่ยนแปลง 

2.  การใช้เครื่องมือตัดต่อแบบกระเพื่อม  (ripple edit):  การปรับจุ ดเข้าและออกของแท่งคลิปอาจ
เรียกได้ว่าเป็นการยืดหดแท่งคลิปบนไทม์ไลน์ได้  แต่การหดคลิปโดยใช้เครื่องมือเลือกวัตถุนั้นจะท้าให้เกิด
ช่องว่างขึ้นบนไทม์ไลน์  หากเราต้องการปิดช่องว่างนี้เราจะต้องลากคลิปที่อยู่ด้านหลังทั้งหมดเข้ามาชิดเอง 
หรือกรณีที่ต้องการยืดคลิปอาจท้าไม่ได้หากมีคลิปอื่นกั้นอยู่  เครื่องมือตัดต่อแบบกระเพื่อมจะแก้ปัญหานี้
ได้ เมื่อหดคลิปมันจะร่นคลิปที่อยู่ต่อจากมันทั้งหมดเข้ามา  และเมื่อยึดคลิปก็จะดันคลิปทั้งหมดที่อยู่ต่อจาก

มันออกไปให้  การเรียกเครื่องมือนี้ออกมาใช้ท้าได้สองวิธีคือ  เรียกโดยตรงจากพาแนลเครื่องมือ   
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หรือกดอักษร  B ที่แป้นพิมพ์  ส่วนอีกวิธีหนึ่งก็คือการแปลงจากโหมดเลือดวัตถุ    เมื่อเลื่อนเข้าไปยัง
ขอบของคลิปที่ต้องการยึดหรือหด ให้กดปุ่ม  Ctrl  ค้างไว้ด้วย สังเกตที่ตัวช้ีจะเปลี่ยนไปคือเป็นสัญรูป
กระเพื่อมเข้า    หรือ กระเพือ่มออก  แต่มีขนาดและความหนามากหว่า  แสดงว่าท่านได้เข้ามาสู่โหมดการตัด
ต่อแบบกระเพือ่มแล้ว  
 
 

Toolbox 
Selection tool      
Track Selection tool     
Ripple Edit tool   
Rolling Edit tool      
Rate Stretch tool      
Razor tool 
Slip tool     
Slide tool   

  Pen tool      
Hand tool    
Zoom tool 

 
 
 

รูปที่ 11 แสดงกล่องเครื่องมือ (Toolbox) ที่ใช้ในการตัดต่อบนพรีเมียร์ 
 

3.  การใช้โหมดตัดต่อแบบม้วน  (Rolling  edit) การปรับจุดเข้าออกแบบกระเพื่อมจะกระท้ากับ
คลิปเดียวและท้าทีละจุด  ต่างกับการใช้เครื่องมือแบบม้วนที่จะท้าระหว่างคลิป  หมายถึงการปรับจุดออก
ของคลิปที่อยู่ก่อนหน้ากับจุดเข้าของคลิปที่ตามมาที่อยู่ติดกันไปพร้อม ๆ กัน  เปรียบเหมือนการน้าฟิล์มสอง
ม้วนมาชนกัน  เมื่อม้วนหลังม้วนกลับม้วนที่อยู่ด้านหน้าจะต้องคลี่ออก  มิฉะนั้นจะเกิดช่องว่างขึ้น  ในทาง
กลับกัน  เมื่อม้วนหน้าม้วนกลับ  ม้วนที่อยู่ด้านหลังก็ต้องคลี่ออกการจะตัดต่อแบบโรลลิ่งได้  คลิปที่มาชน
กันจะต้องมีพื้นที่ปรับเล็มเหลืออยู่  มิฉะนั้นอาจจะคลี่ไม่ออกเพราะเนื้อคลิปจริงหมดไปแล้วการตัดต่อแบบ
โรลลิ่งยังใช้ส้าหรับการตัดแยก  (Split edit) เมื่อต้องการสร้างแรงกระตุ้น  (Motivation)  ในการเปลี่ยนช็อต
โดยให้เสียงมาก่อนภาพ  หรือเสียงหมดทีหลังภาพ โดยการล็อคเสียงไว้ไม่ให้เปลี่ยนแปลงแล้วท้าการม้วน
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ภาพไปมาซึ่งถือเป็นงานหลักของการตัดต่อช็อตบทสนทนา(dialog scene)  หรือบทละคร  (dramatic Scene)  

ต่าง ๆ เครื่องมือม้วน   คลิกได้จากพาแนลเครื่องมือเช่นกัน หรือใช้วิธีกดอักษร  N บนแป้นพิมพ์ก็ได้ 
4. การใช้งานโหมดปรับเล็ม (Trim) : เป็นวิธีการปรับจุดเข้าออกของคลิปสมบูรณ์ที่สุดเพราะ

สามารถท้างานในลักษณะของการตัดต่อแบบกระเพื่อมและแบบม้วนได้ในหน้าจอเดียวกัน นอกจากนั้นยังมี
ฟังก์ชันอ้านวยความสะดวกอีกหลายอย่างเช่น การปรับครั้งละ 1 เฟรม หรือ 5 เฟรม การเล่นเฉพาะจุดตัด 
(play edit) การเล่นวน การเข้าสู่โหมดปรับเล็มต้องเร่ิมจากการเลือกลู่ที่จะท้างานก่อน จากนั้นให้เลื่อนเข็มช้ี
ต้าแหน่งปัจจุบันเข้าไปใกล้ระหว่างจุดต่อของคลิปที่ต้องการปรับ จากนั้นกดปุ่มปรับเล็ม  บนจอโปรแกรม 
หรือกด Ctrl-T บนแป้นพิมพ์ จอปรับเล็มจะปรากฏขึ้นดังรูป ท่านสามารถใช้โหมดการปรับได้ทั้ง 3 แบบ 
คือ โหมดกระเพื่อมกับจุดออกของคลิปซ้าย , โหมดม้วนระหว่างจุดออกของคลิปซ้าย และจุดเข้าของคลิป
ขวา, และโหมดกระเพื่อมกับจุดเข้าของคลิปขวา โดยแต่ละแบบจะมีวิธีการให้ท่านเลือกใช้ตามความถนัด 
เช่น ใช้แบบพิมพ์เปลี่ยนเลขรหัสเวลา หรือจับเลขรหัสเวลาเลื่อนไปมา หรือใช้แถบเลื่อนภาพ (log) ที่อยู่
ด้านล่าง วิธีที่สะดวกที่สุดวิธีหนึ่งคือการเข้าไปเลื่อนภาพบนจอปรับเล็มโดยตรง เช่น เมื่อเลื่อนตัวช้ีไปอยู่

บริเวณรอยต่อระหว่างจอ ตัวช้ีจะเปลี่ยนรูปเป็นเคร่ืองหมายม้วน  เราสามารถคลิกเลื่อนซ้ายขวา เพื่อ
เลื่อนรอยต่อระหว่างคลิปทั้งสองพร้อม ๆ กัน หรือเมื่อเลื่อนตัวช้ีออกห่างจากรอยต่อของจอเล็กน้อย ตัวช้ีก็
จะเปลี่ยนเป็นแบบกระเพื่อมเข้า หรือ กระเพื่อมออก ขึ้นอยู่กับตัวช้ีว่าอยู่บนจอของคลิปใด 
 

ข้ันที่ 4 การสร้างและซ้อนไตเติ้ล (title) 
การซ้อนตัวหนังสือหรือรูปภาพลงบนภาพถือเป็นงานส้าคัญอย่างหนึ่งในกระบวนการตัดต่อวีดิโอ

ที่จะขาดไม่ได้ ในการท้างานเราจะแยกออกเป็น 2 ขั้นตอน คือ ขั้นตอนในการสร้าง และขั้นตอนในการซ้อน 
ขั้นตอนในการสร้าง หมายถึง การใช้โปรแกรมเฉพาะส้าหรับสร้างและออกแบบไตเติ้ลที่มีจ้าหน่าย

มากมายทั้งในรูปของโปรแกรมหลักและแบบโปรแกรมเสริม หรือ อาจเป็นโปรแกรมกราฟิกหรือตบแต่ง
ภาพทั่วไปที่สนับสนุนการท้างานทางด้านนี้ ในส่วนขอพรีเมียร์เองก็มีการอ้านวยความสะดวกโดยฝัง
โปรแกรมสร้างไตเติ้ลไว้ในตัว อย่างไรก็ตาม เนื้อหาในตอนนี้จะไม่เจาะลึกถึงการสร้างไตเติ้ลเพราะจะต้อง
ใช้พื้นที่หนึ่งตอนใหญ่ ๆ แต่เพื่อความสมบูรณ์ของเนื้อหา จึงขอแนะน้าหลักการสร้างไตเติ้ลจากพรีเมียร์มา
อธิบายให้พอเป็นแนวทางการท้างานก่อนที่จะน้าเสนอในภาคต่อไป 

ในรูปภาพปกติจะประกอบด้วยช่องหรือแม่สี 3 สี คือ แดง เขียว และน้้าเงิน รูปภาพยังสามารถมี
ช่องพิเศษอีกช่องหนึ่งเป็นช่องที่ 4 ซึ่งปกติจะมองไม่เห็น ช่องนี้จะบรรจุข้อมูลความโปร่งใสของส่วนต่าง ๆ 
ของภาพ และจะแสดงหรือมีผลเฉพาะโปรแกรมที่รู้จักมันเท่านั้น การซ้อนไตเติ้ลจะใช้คุณสมบัติของ
ช่องอัลฟานี้มาก้าหนดความโปร่งใสให้กับส่วนที่ไม่ต้องการให้มองเห็น หรือให้ส่วนนั้นของภาพทะลุเห็น
ภาพหรือวิดีโอที่อยู่ข้างหลังได้ เรียกว่าการบัง (matte) ภาพ ส่วนที่เป็นสีขาวของการบังปกติจะให้ภาพที่มัน
ซ้อนอยู่มีความทึบแสงสมบูรณ์ หมายถึง มองเห็นได้โดยไม่เห็นภาพที่ซ้อนอยู่ด้านหลัง แต่ในส่วนที่เป็นสี
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ด้าจะมีความโปร่งใสจนมองไม่เห็นตัวมันเอง นอกจากภาพหรือวิดีโอที่อยู่ด้านหลัง ส้าหรับสีที่อยู่ระหว่าง
กลางหรือสีเทา จะท้าให้ภาพมีความโปร่งใสขึ้นจนมองเห็นภาพที่อยู่ด้านหลังมากหรือน้อยตามระดับความ
เข้มของสีเทาบนแมตนั้น 

รูปแบบแฟ้มข้อมูลที่สนับสนุนช่องอัลฟามีมากมายเร่ิมตั้งแต่แฟ้มตระกูล psd ของ Photoshop, 
Electic Image, TGA, TIFF, EPS, PDF, QuickTime, และ IIIustrator เป็นต้น 
 

การสร้างไตเต้ิลจากพรีเมียร์ 
เรียกค้าสั่งสร้างไตเติ้ลใหม่จากเมนู File>New>Title หรือกดF9 ที่แป้นพิมพ์น้าต่างออกแบบไตเติ้ล

จะปรากฏขึ้นพร้อมกับภาพพื้นหลังที่ต้าแหน่งเข็มช้ีเวลาปัจจุบันชี้อยู่ ภาพพื้นหลังนี้จะช่วยให้การออกแบบ
ลักษณะและสีของไตเติ้ลให้เหมาะสมกับพื้นหลัง คือไม่ให้สีกลืนกันมากจนเห็นไตเติ้ลได้ยาก หรือไตเติ้ล
ไปบังส่วนส้าคัญของภาพมากเกินไป อย่างไรก็ตามเราสามารถคลิกเครื่องหมายถูก หน้า Show Vid.. ออก
เพื่อยกเลิกภาพพื้นหลังนี้ 

สิ่งที่ควรจะก้าหนดก่อนการลงมือสร้างไตเติ้ลก็คือการเลือกประเภทของไตเติ้ลก่อนว่าจะให้เป็น
ภาพนิ่ง( Still) เลื่อนขึ้น(Roll) หรือเลื่อนข้าง(Crawl) โดยการกดปุ่มRoll Crawl ใต้ช่ือไตเติ้ลซึ่งปกติถ้าสร้าง
ครั้งแรกพรีเมียร์จะให้ช่ือเป็น Title 01 และเพิ่มตัวเลขขึ้นเร่ือยๆหากไม่มีการเปลี่ยนชื่อเป็นอย่างอื่น สิ่ง
ส้าคัญอีกอย่างหนึ่งก็คือเส้นกรอบกันตก (Safe Area) ไม่ควรเอาออก กรณีที่มันไม่แสดงออกมาให้ไปที่ 
Title>View บนแถบเมนู หรือเรียกจากรายการค้าสั่งของพาแนลไตเติ้ล (สามเหลี่ยมเล็กๆมุมขวาบน) คลิกให้
เกิดเครื่องหมายถูกหน้ารายการ Safe Title Margin หรือจะเปิด Safe Action Margin ด้วยก็ได้ กรอบกันตก
ของไตเติ้ลจะอยู่ขอบในเพื่อเป็นแนวในการใส่ไตเติ้ลไม่ให้ออกนอกบริเวณนี้มิฉะนั้นอาจจะตกจอหรือมอง
ไม่เห็นบนจอโทรทัศน์ ส่วนกรอบนอก จะเป็นกรอบแสดงที่อนุโลมให้ตกหายได้บ้างเพราะยังส่ือ
ความหมายได้ ต่างกับไตเติ้ลซึ่งส่วนใหญ่เป็นตัวหนังสือ หากอักษรตัวแรกหรือตัวสุดท้ายตกจอไปเรา
อาจจะอ่านไม่รู้เร่ืองหรือความหมายผิดไป เช่นค้าว่า  ‚กอดกัน‛ หากตัว ‚ ก‛ ตกไปจะกลายเป็น ‚อดกัน‛ 
เป็นต้น 
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รูปที่ 12 

 
จากรูปที่ 12 จะเห็นเครื่องมือในการสร้างสรรค์ไตเติ้ลที่เพียงพอต่อการท้างานทั่วไป กล่าวโดยสรุป

เราสามารถใช้ไตเติ้ลของพรีเมียร์ท้าสิ่งต่างๆต่อไปนี้ 
 รูปทรงเลขาคณิพื้นฐาน 
 สร้างตัวอักษร และเลือกใช้สไตล์ของตัวอักษรที่จัดไว้ล่วงหน้ากว่า 100 แบบ 
 ก้าหนดสี กรอบ เงา ความโปร่งใส ต้าแหน่ง มุม ล้าดับช้ันของวัตถุ และตัวอักษร 

เนื่องจากฟังก์ชันการท้างานกับไตเติ้ลนั้นออกแบบให้ใช้งานง่ายอยู่แล้ว ดังนั้นสามรถใช้
ประสบการณ์ทดลองสร้างไตเติ้ลแบบต่างๆได้โดยไม่ต้องอ่านคู่มือ หลังจากที่ได้ไตเติ้ลตามต้องการแล้วให้
ปิดพาแนล ( คลิกกากบาดมุมบนขวา ) เพื่อเลิกหรือคลิกปุ่ม New Title Based on Current Title หน้าปุ่ม 
Roll/Crawl เพื่อสร้างไตเติ้ลตัวต่อไปโดยอาศัยไตเติ้ลปัจจุบันเป็นแม่แบบไตเติ้ลที่สร้างขึ้นจะปรากฏเป็น
อัตรสาร รายการหนึ่งในพาแนล Project เรียกง่ายๆว่าไตเติ้ลคลิป  เราจะน้าไตเติ้ลคลิปนี้ไปใช้ในขั้นตอน
การซ้อนไตเติ้ลต่อไป ไตเติ้ลคลิปจะต้องวางอยู่ในลู่ที่สูงกว่าภาพ หรือไตเติ้ลอื่นที่ซ้อนอยู่ด้านล่าง ‚ไตเติ้ลที่
ท้าจากพรีเมียร์จะสร้างช่องอัลฟาให้ในตัว  โดยให้ส่วนที่ไม่ใช่วัตถุหรือพื้นของไตเติ้ลเป็นสีด้าจะได้ทะลุ
มองเห็นภาพด้านล่าง ส่วนของวัตถุปกติจะเป็นสีขาวเพื่อให้มองเห็น ส่วนเงาหรือแถบ( banner) จะเป็นสีเทา
เพื่อให้มีความโปร่งใสบางส่วน อย่างไรก็ตามเราสามารถปรับสีของช่องอัลฟานี้ได้จากการปรับความทึบ     
( opacity) ในช่องคุณสมบัติ( transform properties) ของวัตถุนั้นๆในโปรแกรม 
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ไตเติ้ลของพรีเมียร์ ช่องอัลฟาของคลิปใดๆสามารถดูได้เมื่อน้าไปวางบนจอเซอร์สแล้วเปลี่ยนการ
แสดงผลจากปกติเป็น Composite Video ไปเป็น Alpha โดยใช้ปุ่มค้าสั่งพาแนล (สามเหลี่ยมบนขวา) ของจอ
เซอร์สพรีเมียร์รุ่นปัจจุบันจะน้าช่องอัลฟามาใช้งานทันทีหากพบว่าคลิปมีช่องอัลฟาอยู่เพื่อเพิ่มความสะดวก
ในการท้างาน เราไม่จ้าเป็นจะต้องลากเอฟเฟ็กต์ในการเจาะภาพมาใส่เหมือนรุ่นเก่าๆ 

 

ข้ันที่ 5 การใส่เอฟเฟ็กต์ (Effect) และทรานซิชัน (Transition) 
แต่เดิมพรีเมียร์แบ่งเอฟเฟ็กต์เป็นสองประเภท คือ ฟิลเตอร์ ( Filter) และทรานซิชัน  (transition) 

ฟิลเตอร์จะเป็นเอฟเฟ็กต์ที่ใส่ลงในคลิปเพื่อให้คลิปเกิดการเปลี่ยนแปลงในลักษณะต่างๆ เช่น การ
ปรับเปลี่ยนสี การท้าภาพมัว การท้าภาพช้า /เร็ว นอกจากนั้นยังมีเอฟเฟ็กต์ที่เกี่ยวกับเสียง เช่น การท้าเสียง
ก้อง การเพิ่ม/ลดความดัง การปรับอีควอไลเซอร์ส่วนทรานซิชันจะเป็นเอฟเฟ็กต์ที่กระท้าระหว่างการเปลี่ยน
ภาพหนึ่งไปยังอีกภาพหนึ่งที่อยู่ติดกัน เช่น การท้าภาพจางซ้อน การปาด และการพลิกม้วนภาพ เป็นต้น 

พรีเมียร์รุ่นปัจจุบันได้เปลี่ยนวิธีเรียกช่ือใหม่โดยเรียก ‚ฟิลเตอร์‛ เดิมเป็น ‚เอฟเฟ็กต์ ‛ ส่วน ‚ทราน
ซิชัน‛ นั้นเป็นพรีเมียร์ไม่เรียกว่าเอฟเฟ็กต์อีกต่อไป แต่เรียกเป็น ‚ทรานซิชัน ‛ เฉยๆเราจะพบรายการของ
เอฟเฟ็กต์และทรานซิชันบนพาแนล Effect ซึ่งมีการแบ่งออกเป็นหมวดหมู่หลัก และหมวดหมู่ย่อย เรา
สามารถเปิด/ปิดรายการหมวดหมู่เหล่านี้ออกมาโดยการคลิกที่สามเหลี่ยมหน้าหมวดหมู่นั้นๆ 

กรณีที่เราทราบช่ือ หรือบางส่วนของของช่ือ เราสามารถพิมพ์ส่วนของช่ือนั้นในช่อง Contains: ที่
กรอบของพาแนล Effect พรีเมียร์จะน้าเอฟเฟ็กต์ที่มีส่วนของช่ือตามที่ระบุใน Containsมาแสดงในช่อง
รายการด้านล่าง ข้อควรระวังก็คือ อย่าลืมลบช่ือใน Contains ให้หมดเมื่อต้องการให้เอฟเฟ็กต์ทั้งหมด
กลับมาแสดงเหมือนเดิม 

การใส่ทรานซิชัน 
ทรานซิชันเป็นเอฟเฟ็กต์ชนิดหนึ่งที่ใช้แสดงวิธีการเปลี่ยนจากคลิปหนึ่งไปยังอีกคลิปหนึ่ง ทรานซิ

ชันจึงต้องใส่ระหว่างคลิปสองคลิปที่วางชนกันบนไทม์ไลน์ การจะใส่ทรานซิชันจึงจ้าเป็นต้องมีพื้นที่ปรับ
เล็มเพียงพอต่อความยาวของทรานซิชันที่ต้องการ (ทบทวนการวางคลิปบนไทม์ไลน์ ) วิธีง่ายๆในการสร้าง
พื้นที่ปรับเล็มก็คือการหดส่วนท้ายของคลิปแรกและหดส่วนหน้าของคลิปหลังโดยใช้เครื่องมือตัดต่อแบบ
กระเพื่อม การใส่ทรานซิชันมีขั้นตอนดังนี้ 
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รูปที่  13 พาแนล Effect  
1. คลิกสามเหลี่ยมหน้า Video Transitions หรือ Audio Transitions บนพาแนล Effect เพื่อแสดง

กลุ่มทรานซิชันต่างๆ 
2 .คลิกสามเหลี่ยมหน้ากลุ่มทรานซิชันเพื่อแสดงรายการทรานซิชัน 
3. คลิกลากทรานซิชันที่ต้องการไปปล่อยระหว่างคลิปสองคลิปที่ชนกันที่เตรียมพื้นที่ปรับเล็มไว้

แล้ว กรณีทรานซิชันภาพให้ปล่อยระหว่างรอยต่อคลิปในลู่วิดีโอและปล่อยนะหว่างรอยต่อ 
คลิปในลู่เสียงในกรณีทรานซิชันเสียง 

4. แถบทรานซิชันจะเกิดขึ้นคร่อมระหว่างรอยต่อคลิปทั้งสองและจะแสดงช่ือทรานซิชันนั้นหากมี
การปรับแสดงขนาดของคลิปที่เหมาะสม 

รูปที่ 14 พาแนล Effect Control 
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การลบทรานซิชัน 
คลิกทรานซิชันที่วางอยู่บนรอยต่อคลิปบนไทม์ไลน์แล้วกดปุ่ม Del บนแป้นพิมพ์ หรือคลิกขวาที่  

ทรานซิชันบริเวณรอยต่อของคลิปบนไทม์ไลน์แล้วเลือกค้าสั่ง Clear จากบริบทเมนู 
 
การเปลี่ยนทรานซิชันใหม่ 
ท้าวิธีเดียวกับการใส่ทรานซิชันคร้ังแรก ทรานซิชันเดิมที่ใส่ไว้จะถูกแทนที่โดยทรานซิชันใหม่ 
 
การปรับแต่งทรานซิชัน 
ทรานซิชันแต่ละแบบอาจจะมีวิธีการปรับแต่งแตกต่างกันบ้าง เช่น บางทรานซิชันอาจมีการก้าหนด

ต้าแหน่งหรือมุมการเร่ิมต้นของทรานซิชัน การก้าหนดพารามิเตอร์ของเอฟเฟ็กต์ด้วยตนเอง (Custom) หรือ
บางทรานซิชันต้องมีการก้าหนดแฟ้มภาพประกอบทรานซิชันด้วย เป็นต้น ส้าหรับการปรับที่ไม่ซับซ้อน 
เช่น ระยะเวลาของทรานซิชันสามารถปรับบนไทม์ไลน์ได้โดยตรง โดยคลิกที่ขอบของทรานซิชันนั้นแล้ว
ยืดหรือหดทรานซิชันนั้นที่ละข้าง เราอาจจะยืดทรานซิชันไม่ออกหากพื้นที่ปรับเล็มของคลิปไม่เพียงพอ 

การปรับแต่งทรานซิชันที่สมบูรณ์จะกระท้าบนพาแนล Effect Controls โดยคลิกเลือกทรานซิชัน
ซึ่งอยู่บนของคลิปบนไทม์ไลน์แล้วเข้าไปจัดการในพาแนล Effect Controls บนพาแนลนี้ เราสามารถเปิด
ช่องไทม์ไลน์ปรับความยาวของทรานซิชันดูตัวอย่างเอฟเฟ็กต์ (Play the transition) ก้าหนดเปอร์เซนต์
เร่ิมต้นและสิ้นสุดของทรานซิชัน (start / end) แสดงทรานซิชันด้วยภาพจริงของ 
คลิปทั้งสอง (show actual sources)กลับทิศทางของทรานซิชัน ( reverse) และการก้าหนดขนาดความกว้าง
(border width) และสีของกรอบ( border color) นอกจากนี้ยังมีการก้าหนดการฟุ้งขอบ( anti-aliasing quality) 
เพื่อลดรอยหยักและการก้าหนดพารามิเตอร์ของเอฟเฟ็กต์ด้วยตนเอง(custom)เป็นต้น 

 
การใส่เอฟเฟ็กต์ให้กับคลิป 
การน้าเอฟเฟ็กต์จากพาแนล Effect มาใส่ให้กับคลิปบนไทม์ไลน์ มีขั้นตอนดังนี้ 
1. คลิกสามเหลี่ยมหน้า Video Effect หรือAudio Effects บนพาแนล Effect เพื่อแสดงกลุ่มเอฟเฟ็กต์

ต่างๆ 
2. คลิกสามเหลี่ยมหน้ากลุ่มเอฟเฟ็กต์เพื่อแสดงรายการเอฟเฟ็กต์ต่างๆ 
3. เลือกวิธีต่อไปนี้คือ 
     3.1 คลิกลากเอฟเฟ็กต์ที่ต้องการไปปล่อยลงบนคลิปบนไทม์ไลน์ที่ต้องการใส่เอฟเฟ็กต์ กรณี

เอฟเฟ็กต์ภาพให้ปล่อยลงคลิปในลู่วิดีโอ และปล่อยลงบนลู่เสียงกรณีเอฟเฟ็กต์เสียง 
     3.2 คลิกเลือกคลิปบนไทม์ไลน์ที่ต้องการใส่เอฟเฟ็กต์ คลิกเปิดพาแนล Effect Controls (ปกติจะ

อยู่ในกรอบเดียวกับจอเซอร์ส) แล้วจึงลากเอฟเฟ็กต์ที่ต้องการไปปล่อยลงบนพาแนล Effect Controls ที่เปิด
ไว้ของคลิปนั้น 
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เอฟเฟ็กต์แบบถาวร (Fixed effects) 
นอกจากเอฟเฟ็กต์ปกติที่เราใส่ให้กับคลิปเองแล้ว ยังมีเอฟเฟ็กต์อีกประเภทหนึ่งที่เสมือนเป็น

คุณสมบัติที่อยู่กับคลิปทุกตัว (build-in) ที่วางอยู่บนไทม์ไลน์ คุณสมบัติเหล่านั้นก็คือ 
 การเคลื่อนที่  (motion) ซึ่งประกอบด้วยการระบุต้าแหน่ง  (position) ขนาด scale) การหมุน 

(rotation) จุดอ้างอิงต้าแหน่ง (anchor point) และตัวกรองการกระพริบ (anti-flicker) 
 ความทึบ (opacity) หรือความโปร่งใสเพื่อให้มองเห็นภาพที่ซ้อนอยู่ด้านล้างมากหรือน้อย 
 ความดัง (volume) ใช้ปรับความดังของคลิปเสียง หรือคลิปวิดีโอที่มีเสียงด้วย 
 

การลบเอฟเฟ็กต์ 
เอฟเฟ็กต์ที่จะลบได้จะต้องเป็นเอฟเฟ็กต์ปกติที่เราใส่ให้กับคลิปนั้น เอฟเฟ็กต์แบบถาวรจะลบออก

ไม่ได้ 
1. คลิกเลือกบนไทม์ไลน์ที่ต้องการใส่เอฟเฟ็กต์ 
2. คลิกเปิดพาแนล Effect Controls 
3. เลือกเอฟเฟ็กต์ที่ต้องการลบแล้วกดปุ่ม Del บนแป้นพิมพ์ หรือคลิกขวาที่เอฟเฟ็กต์นั้นแล้วเลือก

ค้าสั่ง Clear หรือ Cut จากบริบทเมนู 
 
การปรับแต่งเอฟเฟ็กต์ 
ในการน้าเอฟเฟ็กต์มาใช้งานหลังจากใส่เอฟเฟ็กต์ลงบนคลิปแล้วเราอาจจะต้องปรับแต่ง

พารามิเตอร์ของเอฟเฟ็กต์นั้นให้เหมาะสมตามความต้องการก่อน การปรับพารามิเตอร์เหล่านี้จะท้าบน
พาแนล Effect Control ซึ่งปกติจะอยู่บนกรอบเดียวกันกับจอเซอร์ส กรณีที่พาแนลนี้หายไปหรือไม่แสดง
ออกมา ให้เรียกออกมาด้วยค้าสั่ง Window>Effect Controls จากแถบเมนู 
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รูปที่ 15 พาแนล Effect Controls 

 
จากรูป 15 จะเห็นเอฟเฟ็กต์แบบถาวรที่มีอยู่ในคลิปทุกตัวที่วางอยู่บนไทม์ไลน์ การจัดการกับ     

เอฟเฟ็กต์ให้คลิกเลือกคลิปในซีเควนซ์ แล้วคลิกเปิดพาแนล Effect Controls ออกมา หากคลิปนี้ยังไม่ได้ใส่
เอฟเฟ็กต์ใดๆลงไปเราจะเห็นรายการเอฟเฟ็กต์ถาวร Motion , Opacity, และ Volume บนพาแนล คลิก
สามเหลี่ยมหน้ารายการเพื่อเปิดรายละเอียดออกมา จากรูปเมื่อเปิดรายการ Motion จะพบรายการย่อยอีก
หลายรายการ และบางรายการก็จะมีสามเหลี่ยมหน้ารายการหลักจะมีสัญลักษณ์ (สัญลักษณ์รูป )บอกว่าเอฟ
เฟ็กต์นี้ท้างานหรือมีผลกับคลิปนั้น เราสามารถหยุดการท้างานเพื่อไม่ให้เอฟเฟ็กต์ดังกล่าวมีผลใดๆกับคลิป
นั้นโดยคลิกสัญลักษณ์นั้นให้หายไป รูปนาฬิกา (รูปสัญลักษณ์ ) หน้ารายการย่อยแสดงว่าเราสามารถ
เปลี่ยนแปลงพารามิเตอร์ของรายการนั้น ณ เวลาต่างๆได้ เรียกปุ่มนี้ว่า ปุ่มเปิดปิดชีวลักษณ์ ( toggle 
animation) เนื่องจากเวลาของการปรับพารามิเตอร์นี้จะตรงกับกรอบภาพ(frame)ใดกรอบภาพหนึ่งจึงเรียกว่า 
คีย์เฟรม หรือกรอบภาพหลัก ( key frame) กรอบภาพจะเป็นหน่วยวัดที่เล็กที่สุดของหน่วยนับตามมาตรฐาน
รหัสเวลา( time code) ของ SMPTE ซึ่งมีรูปแบบเป็นชั่วโมง:นาที:วินาที:กรอบภาพ เช่น 00:02:12:23 ดังนั้น
แม้จะเป็นคลิปเสียงซึงไม่มีภาพ ก็ยังใช้หน่วยนับที่กรอบภาพเป็นตัวก้าหนดต้าแหน่งเวลาอยู่ดี ) การเปิดชีว
ลักษณ์(คลิกรูปนาฬิกา) ครั้งแรกจะมีการสร้างเฟรมหลักขึ้นที่เข็มช้ีเวลาปัจจุบันชี้อยู่ หากเส้นบอกต้าแหน่ง
ไม่พาดบนคลิปนั้นบนซีคานซืเราจะมองไม่เห็น (นอกจากจะยกเลิก Pin to Clip) ในค้าสั่งของพาแนลจึงจะ
แสดงส่วนของไทม์ไลน์ที่เกินจากคลิปได้ ) ดังนั้นเพื่อไม่ให้สับสนเราควรวางเข็มช้ีเวลาพาดบนคลิปใน
ต้าแหน่งที่ต้องการสร้างคีย์เฟรมหลักก่อนการเปิดชีวลักษณ์ 

คีย์เฟรมจึงเป็นจุดส้าหรับปรับพารามิเตอร์ต่างๆของเอฟเฟ็กต์สะดวกและยืดหยุ่นในการจัดการกับ
เอฟเฟ็กต์บนคีย์เฟรมถือเป็นเคร่ืองวัดความสามารถของซอฟต์แวร์นั้นทีเดียว เพื่อความสะดวกกับการ
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ท้างานกับคีย์เฟรมเราจะต้องเปิดไทม์ไลน์บนพาแนลก่อน โดยการคลิกที่ปุ่มเปิดไทม์ไลน์ ( hide / show 
timeline view) (รูปสัญลักษณ์ ) ข้อควรระวังก็คื อ หากพาแนล Effect Controls กว้างไม่พอเราจะเปิดไทม์
ไลน์บนพาแนลไม่ได้ เราจะต้องลากขยายกรอบของพาแนลให้มีพื้นที่พอเสียก่อน 

 
การจัดการคีย์เฟรมบน Effect Controls 
หลังจากเปิดพาแนล Effect Controls ของคลิปที่ต้องการปรับแต่งเอฟเฟ็กต์แล้วให้เปิดไทม์ไลน์ของ

พาแนลออกมาเพื่อใช้ก้าหนดต้าแหน่งคีย์เฟรมและเลื่อนดูภาพซ่ึงจะไปปรากฏบนจอโปรแกรม 
คลิกบริเวณรหัสตัวเลขเวลาซึ่งอยู่ส่วนบนสุดของไทม์ไลน์ เข็มช้ีเวลาปัจจุบันจะปรากฏขึ้นพร้อมกับแสดง
ภาพที่จุดนั้นบนจอโปรแกรม ลากเมาส์ไปมาเพื่อหาต้าแหน่งที่ต้องการ จากนั้นจึงคลิกที่ปุ่มชีวลักษณ์ (รูป
นาฬิกา) ของเอฟเฟ็กต์หรือคุณสมบัติย่อยของเอฟเฟ็กต์ที่ต้องการ นาฬิกาแต่เดิมไม่มีเข็มก็จะมีเข็มปรากฏ
ขึ้นพร้อมกับจุดคีย์เฟรมในแถวของเอฟเฟ็กต์นั้น จุดนี้จะเป็นจุดที่ใช้เปลี่ยนแปลงค่าของเอฟเฟ็กต์ที่ใส่ลงไป 
เราสามารถที่จะเพิ่มคีย์เฟรมได้อย่างไม่จ้ากัด โดยคลิกที่ปุ่ม เพิ่ม / ลบ คีย์เฟรม ( add / delete keyframe) (รูป
สัญลักษณ์ )ซึ่งอยู่ระหว่างปุ่มเลื่อนเข็มช้ีเวลาไปยังคีย์เฟรมก่อนหน้าและถัดไป ( next / previous keyframe) 
ปุ่มเพิ่ม/ลบ คีย์เฟรมนี้จะท้าหน้าที่เพิ่มหากไม่มีคีย์เฟรมอยู่ที่ต้าแหน่งที่เข็มช้ีเวลาชี้อยู่ และจะท้าหน้าที่ลบ 
หากต้าแหน่งนั้นมีคีย์เฟรมอยู่แล้ว นอกจากนี้ท่านยังสามารถคลิกเลื่อนหรือย้ายต้าแหน่งคีย์เฟรมไปยัง
ต้าแหน่งใหม่ได้อีกด้วย การท้างานกับคีย์เฟรมจะต้องใช้เครื่องมือเลือกวัตถุที่เป็นศรช้ี ( selection tool) หรือ
ปากกา( pen tool) เสมอ 

การลบคีย์เฟรมทั้งหมดในคร้ังเดียวท้าได้โดยคลิกปลดปุ่มชีวลักษณ์ (คลิกนาฬิกาให้เข็มหาย ) 
โปรแกรมจะเตือนก่อนว่าคีย์เฟรมทั้งหมดจะถูกลบ หลังจากปลดชีวลักษณ์แล้วเอฟเฟ็กต์จะคงค้างไว้
เหมือนกับต้าแหน่งสุดท้ายที่เข็มช้ีเวลาปัจจุบันชี้อยู่ 

กรณีที่มีคีย์เฟรมเพียงจุดเดียว การเปลี่ยนแปลงของเอฟเฟ็กต์ใดๆจะมีผลตลอดคลิปนั้น เทียบกับ
ปรับเอฟเฟ็กต์โดยไม่มีคีย์เฟรม การก้าหนดคีย์เฟรมตั้งแต่สองจุดขึ้นไป ปุ่มรีเซ็ต(reset) จะน้าค่าพารามิเตอร์
เร่ิมต้นของเอฟเฟ็กต์ที่คีย์เฟรมนั้นกลับมาใช้ในกรณีที่การปรับค่ายุ่งเหยิงแล้วตั้งการเร่ิมต้นใหม่ การกดปุ่มรี
เซ็ตในขณะที่เข็มช้ีเวลาไม่ตรงกับคีย์เฟรมใดจะเป็นการสร้างคีย์เฟรมใหม่ที่จุดนั้นให้มีพารามิเตอร์ของเอฟ
เฟ็กต์นั้นเป็นจุดเร่ิมต้นแทนที่จะเป็นค่าปัจจุบันเหมือนกับการเพิ่มคีย์เฟรมตามปกติ 

พารามิเตอร์ของเอฟเฟ็กต์ที่จะใส่ให้กับคีย์เฟรมจะแตกต่างกันขึ้นอยู่กับเอฟเฟ็กต์นั้นๆพารามิเตอร์ที่
เกี่ยวกับขนาด ต้าแหน่ง หรือมุมหมุนบนจอภาพซึ่งเป็นลักษณะของการใช้พื้นที่ (spatial) โดยธรรมชาติ 
นอกจากจะเปลี่ยนโดยวิธีพิมพ์ หรืคลิกเลื่อนตัวเลขแล้ว ยังสามารถเข้าไปปรับบนจอโดยตรง เรียกว่า ใช้การ
ท้างานแบบเส้นทางเดิน(motion path) โดยการกดเครื่องหมายแปลง(transform) (รูปสัญลักษณ์ )หลังรายการ
เอฟเฟ็กต์หรือคุณสมบัติของเอฟเฟ็กต์ แนวกรอบของภาพก็จะปรากฏขึ้น เราสามารถเลื่อนตัวช้ีเข้าไปภายใน
ภาพเพื่อเลื่อนต้าแหน่งหรือเลื่อนเข้าไปใกล้ขอบหรือหรือมุมของแนวกรอบซึ่งมีตัวจับอยู่ 8 จุด ตัวช้ีจะ
เปลี่ยนรูปเป็น เมื่ออยู่ในโหมดหมุนภาพหรือรูปเมื่ออยู่ในโหมดย่อขยาย 
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เราสามารถดูกราฟแสดงปริมาณ(value graph) และกราฟแสดงความเร็ว (velocity graph) ของแต่ละ
เอฟเฟ็กต์ที่เราสร้างคีย์เฟรมไว้ เว้นแต่ค่าของเอฟเฟ็กต์นั้นจะแสดงด้วยปริมาณมากกว่าหนึ่งค่า (เช่นต้าแหน่ง
ภาพที่มีต้าแหน่งแนวตั้งและแนวนอน) ก็จะไม่ปรากฏกราฟแสดงปริมาณออกมา 

กราฟแสดงความเร็ว ใช้บอกความเร็วในการเข้าหรือออกจากค่าของเอฟเฟ็กต์ที่จุดนั้นว่ามากน้อย
เท่าไร มีอัตราที่คงที่ เร่งหรือหน่วง นับเป็นพารามิเตอร์ที่เข้าใจได้ยากพอสมควรโดยเฉพาะอย่างย่ิงหาก
ความเปลี่ยนแปลงของเอฟเฟ็กต์นั้นไม่มากหรือไม่เห็นชัดเจน 

กรณีที่ค่าของเอฟเฟ็กต์ระหว่างคีย์เฟรมสองจุดไม่เปลี่ยนแปลง กราฟความเร็วจะอยู่ที่กึ่งกลางเป็น
เส้นขนานกับแนวระนาบ แต่หากคีย์เฟรมจุดที่สองมีค่าสูงกว่ากราฟความเร็วจะยกสูงขึ้นแต่ยังคงขนานกับ
ระนาบซึ่งหมายถึงการเปลี่ยนแปลงของเอฟเฟ็กต์เร็วขึ้นแต่มีอัตราที่คงที่ จะเห็นได้ชัดเมื่อย่นระยะของคีย์
เฟรมทั้งสองเข้าใกล้กับความเร็วในการเปลี่ยนเอฟเฟ็กต์จะเร็วขึ้น (แม้ว่าความสูงของกราฟจะเท่าเดิมแต่
สเกลตัวเลขบอกความสูงจะเปลี่ยนไป) สิ่งที่หลายคนมักไม่เข้าใจก็คือเมื่อเอฟเฟ็กต์ผ่านคีย์เฟรมจุดที่สองไป
ยังจุดต่อไปท้าไมความเร็วจึงเปลี่ยนแบบกะทันหัน  (เส้นแนวตั้ง ) ที่เป็นเช่นนี้เพราะกราฟความเร็วจะบอก
ความสัมพันธ์ระหว่างจุดสองจุด ความเร็วของการเปลี่ยนเอฟเฟ็กต์ระหว่างจุดที่หนึ่งกับสองจึงไม่เกี่ยวกับ
ระหว่างจุดที่สองกับจุดที่สาม 

อย่างไรก็ตาม คีย์เฟรมดังกล่าวเป็นคีย์เฟรมแบบเส้นตรง (linear) มีสัญลักษณ์เป็นข้าวหลามตัด 
หมายถึงความเร็วในการเปลี่ยนค่าของเอฟเฟ็กต์เท่ากันตลอด เราสามารถเปลี่ยนแปลงประเภทหรือวิธีการ
แต่งเส้น(interpolation) คีย์เฟรมเป็นแบบอื่น เช่น แบบบีเซอร์ (Bezier) ซึ่งจะมีแขนให้เราปรับความโค้งหรือ
อัตราเร่งหรือหน่วงของการเปลี่ยนค่าเอฟเฟ็กต์ให้มีความราบเรียบ (smooth) ได้อย่างอิสระ หรือแบบบีเชอร์
แบบอัตโนมัติ (auto Bwzier) ซึ่งจะปรับอัตราของการเปลี่ยนค่าเอฟเฟ็กต์ให้เอง (แต่เมื่อเราเข้าไปขยับแขน
ของคีย์เฟรมแบบบีเซอร์อัตโนมัติจะเปลี่ยนไปเป็นแบบบีเชอร์ต่อเนื่องทันที ) และแบบบีเชอร์ต่อเนื่อง
(continuous Bezier) ใช้สัญลักษณ์เดียวกันกับแบบบีเซอร์แต่แตกต่างกับบีเซอร์และบีเซอร์อัตโนมัติตรงที่เรา
สามารถปรับแขนของบีเซอร์ได้โดยที่พรีเมียร์จะรักษาความราบเรียบระหว่างการเปลี่ยนแปลงไว้ให้ 
นอกจากนี้ยังมีคีย์เฟรมแบบยึด(hold)(รูปสัญลักษณ์)ซึ่งจะรักษาไม่ให้อัตราการเปลี่ยนเอฟเฟ็กต์เปลี่ยนแปลง 
นั่นคือกราฟความเร็วในช่วงที่มีคีย์เฟรมแบบยึดติดอยู่จะมีแนวขนานกับระนาบเท่านั้น 

 
การจัดการกับคีย์เฟรมบนพาแนล Timeline 
นอกจากจะจัดการกับคีย์เฟรมบนพาแนล Effect Controls แล้ว เรายังสามารถจัดการกับคีย์เฟรมบน

ไทม์ไลน์ได้ด้วย อย่างไรก็ดีการท้างานกับคีย์เฟรมบนไทม์ไลน์จะมีข้อจ้ากัดหลายอย่างเช่น ไม่สามารถ
แสดงคีย์เฟรมพร้อมกันทุกเอฟเฟ็กต์ได้ 

ก่อนที่จะจัดการกับคีย์เฟรมบนไทม์ไลน์อันดับแรกต้องเปิด (enable) ให้แสดงคีย์เฟรมบนไทม์ไลน์
ก่อนกรณีที่ยังเปิดอยู่โดยการคลิกปุ่ม พับ / ขยายลู่ (collapse / expand track) รูปสามเหลี่ยมหน้าช่ือลู่ จากนั้น
ให้คลิกปุ่มแสดงคีย์เฟรม(รูป)(show keyframes) ที่อยู่ส่วนหัวของลู่(เมื่อคีย์เฟรมแสดงแล้วปุ่มแสดงคีย์เฟรม
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จะไม่มีเส้นห้าม(รูปสัญลักษณ์) กรณีของลู่วิดีโอจะมีทางเลือกสามทาง คือ แสดงคีย์เฟรม (show keyframes) 
แสดงระดับความทึบ (show opacity handles)ซึ่งเป็นเอฟเฟ็กต์ถาวรของภาพ และซ่อนคีย์เฟรม (hide 
keyframes) กรณีของลู่เสียงจะมีทางเลือกถึง 5 ทาง เนื่องจากกรณีของเสียงจะแบ่งคีย์เฟรมเป็น 2 ชนิด คือคีย์
เฟรมของศิลป และคีย์เฟรมของลู่ ดังนั้นการแสดงคีย์เฟรมจึงมีสองทางเลือก อีกสองทางเลือกเป็นเอฟเฟ็กต์
ถาวรของเสียง นั่นคือการปรับความดัง (volume) ซึ่งมีทั้งของคลิปและของลู่เช่นกัน สุดท้ายคือการซ่อนคีย์
เฟรมเช่นเดียวกับลู่ภาพ ข้อสังเกตก็คือ ขณะที่เลือกแสดงคีย์เฟรมหรือความดังของลู่คลิปเสียงบนไทม์ไลน์
จะถูกล็อกไม่ให้มีการเคลื่อนย้ายโดยใช้ครื่องมือเลือกวัตถุปกติ แต่ยังสามารถลบและวางเสียงใหม่ได้ 

การจัดการกับคีย์เฟรมจะต้องเลือกท้าที่ละเอฟเฟ็กต์หรือแต่ละคุณสมบัติของเอฟเฟ็กต์โดยการเลือก
จากป๊อปอัพเมนู(pop-up menu) หลังช่ือคลิปที่วางอยู่บนไทม์ไลน์ ในการเพิ่มหรือลบคีย์เฟรมใช้วิธีเดียวกับ
การท้างานบนพาแนล Effect Controls คือเลื่อนเข็มช้ีเวลาปัจจุบันบนไทม์ไลน์ไปยังต้าแหน่งที่ต้องการ ภาพ
ในจุดที่เข็มช้ีเวลาอยู่จะปรากฏบนจอโปรแกรม กดปุ่ม เพิ่ม / ลบ คีย์เฟรม (add / delete / keyframe)(รูป
สัญลักษณ์)ที่หัวของลู่ คลิกขวาที่จุดคีย์เฟรมเพื่อเลือกวิธีการแต่งเส้น (บนไทม์ไลน์จะใช้สัญลักษณ์คีย์เฟรม
เป็นข้าวหลามตัดแบบเดียวแม้วิธีการแต่งเส้นจะต่างกัน )การเลื่อนและกระโดไปยังคีย์เฟรมต่างๆยังใช้
หลักการเดียวกันกับการท้างานบนพาแนล Effect Controls 

เอฟเฟ็กต์หรือคุณสมบัติของเอฟเฟ็กต์ที่มีพารามิเตอร์เพียงตัวเดียวเช่น การปรับขนาด (scale)การ
เลื่อนจากกล้อง (camera blur) การดัด(bend) จะปรับค่าโดยดึงคีย์เฟรมขึ้นลงบนไทม์ไลน์ได้ แต่เอฟเฟ็กต์
หรือคุณสมบัติของเอฟเฟ็กต์ที่มีพารามิเตอร์มากกว่าหนึ่งตัวและไม่แยกการปรับ เช่น ต้าแหน่งจุดร่วม x,y 
จะปรับค่าบนไทม์ไลน์ไม่ได้ 
 

ข้ันที่ 6ปรับแต่งและผสมเสียง (mix) ให้สอดคล้องสัมพันธ์กับภาพ 
เสียงเป็นปัจจัยส้าคัญย่ิงในการผลิตรายการวิดีโอ โทรทัศน์ และภาพยนตร์ รายการที่มีภาพที่

สมบูรณ์ คมชัด การด้าเนินเร่ืองและการตัดต่อภาพยอดเย่ียมแต่หากเสียงไม่มีคุณภาพ ดังหรือเบาเกินไป มี
เสียงรบกวนสูง ไม่เข้าจังหวะหรือสอดคล้องกับภาพ รายการนั้นก็จะด้อยคุณภาพลงไปทันที เสียงในรายการ
โทรทัศน์แบ่งออกเป็น 4 ประเภท คือเสียงสนทนา (narration) เสียงดนตรี (music) และเสียงประกอบ (sound 
effect)การตัดต่อวิดีโอขั้นพื้นฐานจะต้องมีการประกอบเสียงเหล่านี้ลงไปในรายการ เสียงแต่ละประเภทปกติ
จะแยกวางต่างลู่กัน นอกจากนั้นเสียงประเภทเดียวกันอาจจะมีหลายเวอร์ชันหรือหลายทางเลือก จ้านวนลู่
เสียงที่ใช้จึงต้องมีจ้านวนมากขึ้น ประเด็นส้าคัญคือ ท้าอย่างไรจึงจะผสมเสียงทั้งหมดให้เข้ากันได้อย่าง
เหมาะสม กลมกลืน ย่ิงการผสมเสียงรอบทิศ หรือการผสมเสียงดนตรีที่ประกอบด้วยเครื่องดนตรีหลายช้ิน
และบางช้ินต้องใช้ลู่เสียงมากกว่าหนึ่งลู่ (เช่นกลองและแกรนด์เปียโน ) การผสมเสียงก็จะยุ่งยากและใช้ลู่
เสียงเพิ่มเป็นทวีคูณ พรีเมียร์รุ่นปัจจุบัน จึงจัดเครื่องมือผสมเสียงที่มีประสิทธิภาพให้ 
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การจัดการกับเสียงเบื้องต้น 
การจัดการเบื้องต้นเหมือนกับภาพคือ การตัดต่อ ใส่เอฟเฟ็กต์ สามารถดูรูปขึ้นบนจอเซอร์ส การ

ปรับเล็ม การปรับความดัง การแพนซ้ายขวา ทั้งบนไทม์ไลน์และบนพาแนล Effect Controls หรือบน
มิกเซอร์ (mixer) ข้อแตกต่างก็คือลู่ภาพจะมีแบบเดียวไม่ว่าจะเป็นภาพนิ่งหรือวิดีโอแต่ละลู่เสียงคือเป็นแบบ
โมโน (mono) สเตอริงโอ  (stereo) และเสียงรอบทิศ 5.1(surround) ในขณะที่ลู่ภาพจะมีการบังกันโดยลู่บน
จะบังลู่ที่อยู่ต่้ากว่า แต่ลู่เสียทุกลู่จะให้เสียงออกมาผสมกันหมดเว้นแต่จะลดเสียงหรือปิดลู่ที่ไม่ต้องการ
ออกไป 

ประเภทของลู่เสียง 
ในการสร้างโครงการใหม่ทุกครั้งหากเลือกแม่แบบโครงการที่พรีเมียร์เตรียมไว้ให้ (preset) ในส่วน

ของซีเควนซ์จะประกอบด้วยลู่ภาพ 3 ลู่ ลู่เสียงสเตอริโอ 3 ลู่ โดยมีลู่เสียงหลัก (master track) เป็นแบบสเตอ  
ริโอเช่นกัน เราสามารถเพิ่มลู่เสียงประเภทอื่นลงไปในซีเควนซ์ได้โดยค้าสั่ง Sequence>Add Track จากแถบ
เมนู ค้าสั่งนี้นอกจากจะให้เราก้าหนดจ้านวนลู่ภาพและลู่เสียงที่จะเพิ่มลงไปแล้ว ในส่วนของงลู่เสียงยังระบุ
ได้ว่าจะให้เป็นแบบโมโน สเตอริโอ หรือแบบเสียงรอบทิศ นอกจากนี้ยังมีลู่เสียงอีกประเภทหนึ่งที่แตกต่าง
จากลู่เสียงปกติ (regular) อื่นๆให้เลือกคือ ลู่เสียงแบบซับมิกซ์ (submix) เพื่อรับเอาต์พุตหรือเสียงที่จัดส่ง 
(send) มาจากลู่เสียงอื่น เป็นการรวมเสียงจากหลายๆลู่เข้าด้วยกันเพื่อความสะดวกในการจัดการก่อนที่จะ
ส่งไปยังลู่เสียงหลักต่อไป ลู่เสียงซับมิกซ์นี้ยังก้าหนดได้ว่าจะให้เป็นโมโน สเตอริโอ หรือแบบเสียงรอบทิศ 

ส้าหรับลู่เสียงที่ไม่ได้ใช้งานเราสามารถลบทิ้งได้โดยค้าสั่ง Sequence>Add Track เช่นกัน ข้อสังเกต
ก็คือเราไม่สามารถลบและเปลี่ยนชนิดของลู่เสียงหลักได้ เช่นจากสเตอริโอไปเป็นแบบเสียงรอบทิศ เรา
จะต้องท้าตั้งแต่ขั้นตอนการสร้างโครงการใหม่โดยเลือกโครงการแบบตั้งค่าเอง (custom settings) แล้วเข้า
ไปเลือกประเภทของลู่เสียงหลักในหัวข้อ Default Sequence 

การจัดการกับเสียงบนไทม์ไลน์ 
เสียงที่น้ามาวางบนไทม์ไลน์อาจเป็นคลิปเสียงโดดๆ  หรือเป็นเสียงที่ติดมากับคลิปวิดีโอ เสียง

ต้องการลู่ประเภทเดียวกันกับตัวมันเองเท่านั้น หากไม่มีลู่เสียงที่สอดคล้องกัน พรีเมียร์จะสร้างลู่เสียงใหม่
ให้โดยอัตโนมัติเมื่อลากคลิปจากพาแนล Project ไปปล่อยลงบนไทม์ไลน์ กรณีที่ต้องการท้างานกับเสียง
เป็นหลัก พรีเมียร์ได้เตรียมพื้นที่ท้างานกับเสียงไว้ให้เรียกใช้ง่ายๆจากค้าสั่ง Window>Workspace>Audio 
ซึ่งจะแตกต่างจากพื้นที่ท้างานส้าหรับการตัดต่อ  (editing) เล็กน้อยคือจะมีการเปิดพาแนลผสมเสียง  (audio 
mixer) ออกมาแทนหน้าจอเซอร์ส อย่างไรก็ตามท่านสามารถคลิกเปิดพาแนลเอง หรือใช้ค้าสั่ง 
Window>AudioMixer หากไม่พบพาแนลนี้บนพื้นที่ท้างาน 
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การจัดการคลิปเสียงบนไทม์ไลน์จะเหมือนกับคลิปภาพ เช่น การลบ การย้าย การตัดต่อแบบ
กระเพื่อม การใส่ทรานซิชัน และเอฟเฟ็กต์ ความแตกต่างจะมีบ้างเพราะคุณลักษณะของภาพและเสียงนั้น
ต่างกันโดยธรรมชาติอยู่แล้ว เช่น การแสดงคลิปเสียงบนไทม์ไลน์จะเลือกให้แสดงเป็นชื่ออย่างเดียวหรือให้
แสดงเป็นรูปคลื่นด้วย หรือการเลือกแสดงคีย์เฟรมแบบลู่ จะท้าให้คลิปเสียงไม่สารสารถเลื่อนได้ด้วยวิธี
ปกติ ส้าหรับคลิปเสียงที่ติดมากับวิดีโอ จะเช่ือมติด (link) กับภาพและจะถูกลบหรือเลื่อนตามภาพเสมอ 
อย่างไรก็ตามเราสามารถที่จะปลดการเช่ือม(unlink) ได้โดยค้าสั่ง Clip>Unlink จากแถบเมนูในทางกลับกัน
เราสามารถน้าคลิปภาพและเสียงที่ไม่เช่ือมกันมาเช่ือมกันโดยคลิกเลือกคลิปทั้งสอง(กด Shift บนแป้นพิมพ์
เมื่อเลือกคลิปต่อมา ) แล้วใช้ค้าสั่ง  Clip>Link จากแถบเมนูเช่นกัน ค้าสั่ง Clip>Link จะใช้ไม่ได้หากคลิป
ภาพที่เลือกมีเสียงติดอยู่และยังไม่ได้ปลดการเช่ือมออก ค้าสั่ง Clip>Group จะท้างานคล้ายกับ Clip>Link แต่
จะใช้กับคลิปใดๆก็ได้และไม่จ้าเป็นต้องเป็นภาพกับเสียงเท่านั้น 

เครื่องผสมเสียง (Audio Mixer) 
การจัดการกับเสียงจะท้าให้ได้เต็มที่เมื่อเปิดพาแนล Audio Mixer ออกมา พาแนลนี้จะถอดแบบการ

ท้างานของเครื่องผสมเสียงที่ใช้งานจริงในสตูดิโอ ลู่เสียงทุกลู่บนไทม์ไลน์จะแสดงออกมาเป็นช่องเสียง 
(audio channel) บนเคร่ืองผสมเสียง จากรูปที่ 33 จะเห็นเครื่องผสมเสียงที่ประกอบด้วยลู่เสียงทั้งหมด 5 ลู่
เสียง เป็นลู่เสียงที่มีคลิปจริง 3ลู่ ลู่เสียงซับมิกซ์ 1 ลู่ และลู่เสียงหลัก 1 ลู่ 

ต่อไปนี้เป็นหน้าที่ของส่วนต่างๆรียงล้าดับจากบนสุดในเครื่องผสมเสียง ตามรูปที่ 16 
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รูปที่ 16 

1.  ช่ือลู่ เป็นชื่อเดียวกับช่ือลู่บนไทม์ไลน์และสามารถคลิก เพื่อเปลี่ยนชื่อให้สอดคล้องกับเสียงที่
วางอยู่บนลู่นั้น 

2.  รหัสเวลา บอกต้าแหน่งที่เข็มช้ีเวลาปัจจุบันชี้อยู่บนไทม์ไลน์ 
3.  โหมดเปลี่ยนอัตโนมัติ (Automation) ใช้บันทึกล้าดับการผสมเสียง (write) และน้าบันทึกนั้นมา

ท้าซ้้า (read) โดยอนุญาตให้มีการแก้ไขเฉพาะจุดที่เครื่องมือถูกบังคับ (touch) ให้ต่างไปจากเดิม หรือแก้ไข
ไปตลอดตามต้าแหน่งที่เครื่องมือถูกปรับปรุงคร้ังล่าสุด (Larch) 

4.  ช่องใส่เอฟเฟ็กต์ คล้ายกับเอฟเฟ็กต์ที่ใส่ให้กับคลิปเสียงที่อยู่บนไทม์ไลนืแต่เอฟเฟ็กต์นี้จะมีผล

3 

2 

4 

1 
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6 
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12 
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กับทุกคลิปบนลู่นั้นคลิกสามเหลี่ยมแต่ละบันทัดในช่องเอฟเฟ็กต์เพื่อแสดงและเลือกรายการเอฟเฟ็กต์ที่
ต้องการ แต่ละลู่จะใส่เอฟเฟ็กต์ได้ไม่เกิน 5 เอฟเฟ็กต์ (หากไม่พอสามารถส่งต่อไปให้ซับมิกซ์ท้างานต่อไป
ได้อีก) กรณีที่ช่องใส่เอฟเฟ็กต์และช่องส่งสัญญาณออกในหัวข้อต่อไปไม่แสดงออกมาให้คลิกสามเหลี่ยม 
Show/Hide Effects and Send ซึ่งอยู่บริเวณกรอบซ้ายของเครื่องผสมเสียงเสียก่อน 

5.  ช่องส่งสัญญาณออก ปกติใช้ส่งสัญญาณไปให้ซับมิกซ์เพื่อด้าเนินการทางด้านเอฟเฟ็กต์ ซับมิกซ์
จะคืนสัญญาณที่ด้าเนินการแล้วกลับไปผสมเสียงต่อจากลู่เสียงหลักหรือส่งต่อไปยังซับมิกซ์อื่นต่อไปช่อง
ส่งจะมีปุ่มปรับอัตตราส่วนของเสียงที่ส่งไปยังซับมิกซ์ เรียกว่าอัตรส่วนเปียก /แห้ง (Wet/dry/radio) ค้าว่า
เปียก หมายถึง สัญญาณที่ผ่านการท้าเอฟเฟ็กต์ทางซับมิกซ์ ส่วนแห้ง หมายถึงสัญญาณจากช่องส่งเดิม 
อัตราส่วนเปียก /แห้ง 100% แสดงว่าสัญญาณเปียกส่งออกสูงสุด ตัวปรับความดังของซับมิกซ์จึงมีผลกับ
สัญญาณเปียกในขณะที่ตัวปรับความดังของตัวส่งจะมีผลกับสัญญาณแห้ง ช่องส่งสัญญาณออกมีได้ 5 ช่อง 
แต่ละช่องสามารถก้าหนดได้ว่าจะให้ผ่านตัวปรับควมดัง (fader) ของลู่หรือไม่โดยการคลิกขวาที่ช่องส่งนั้น 
ๆ ทางเลือก Pre-Fader และ Post- Fader จะแสดงออกมา หากเลือก Pre Fader สัญญาณจะไม่ผ่านตัวปรับ
ความดังของลู่จึงไม่มีผลต่อสัญญาณที่ส่งออกไปยังซับมิกซ์ หากเลือก Post Fader สัญญาณจะผ่านตัวปรับ
ความดังของลู่ส่งก่อน จึงเท่ากับเป้นการรักษาอัตราส่าวนเปียก/แห้ง ไว้ไม่ให้เปลี่ยนแปลง 

6.  ปุ่มปรับค่า ใช้ปรับค่าเอฟเฟ็กต์ หรืออัตราส่วนเปียก /แห้ง การดูว่าปุ่มปรับค่าในขณะนั้นท้า
หน้าที่อะไรอยู่ให้ดูที่เครื่องหมายก้ากับด้านข้าง  หากเครื่องหมายเป็นรูป  (รูป)   แสดงว่าปุ่มปรับค่าจะท้า
หน้าที่ปรับค่าคุณสมบัติของเอฟเฟ็กต์ตัวใดตัวหนึ่งซึ่งเลือกจากรายการป๊อปอัปเมนู (สามเหลี่ยม) ใต้ปุ่มปรับ
ค่า แต่หากเครื่องหมายเป็นรูป(รูป)   แสดงว่าปุ่มปรับค่าท้าหน้าที่ปรับอัตราส่วนเปียก/แห้ง อยู่ การคลิกเลือก
รายการในส่วนเอฟเฟ็กต์ หรือช่องส่งจะเป็นการเปลี่ยนหน้าที่ของปุ่มปรับนี้ การคลิกให้เครื่องหมายก้ากับมี
เส้นคาด จะเป็นการยกเลิกการท้างานของเอฟเฟ็กต์หรือการส่งนี้ออกไป 

7.  ส่วนควบคุมการแพน (pan) และการจัดสมดุลเสียง (balance) ขึ้นกับจ้านวนช่องเสียงของช่อง
เสียงของลู่ส่งและลู่รับ เช่นเมื่อลู่ส่งเป็นโมโนและลู่รับเป็นสเตอริโอหรือเสียงรอบทิศส่วนนี้จะท้าหน้าที่เป็น
แพน คือจะปรากฏปุ่มหมุนปรับให้สัญญาณไปทางซ้ายหรือขวา กรณีสเตอริโอ หรือเป็นถาดสี่เหลี่ยม
ส้าหรับก้าหนดต้าแหน่งหรือความแรงของสัญญาณ กรณีเสียงรอบทิศ หรือกรณีที่ลู่ส่งเป็นสเตอริโอ และลู่
รับเป็นสเตอริโอหรือเสียงรอบทิศปุ่มและถาดรับสัญญาณจะท้าหน้าที่จัดสมดุลเสียงหมายถึงการเพิ่มหรือลด
เสียงที่จะส่งไปยังลู่ที่ตรงกัน เช่นจากลู่ซ้ายไปยังลู่ซ้ายและลู่ขวาไปยังลู่ขวา การจัดสมดุลเสียงต่างจากการ
แพนเสียงตรงที่ เสียงมีการแยกช่องไว้แล้ว ในกรณีที่ช่องเสียงเท่ากัน (ยกเว้นสเตอริโอไปสเตอริโอ ) จะไม่มี
ส่วนควาบคุมนี้เกิดขึ้น กรณีสุดท้ายเมื่อลู่ส่งมากกว่าลู่รับพรีเมียร์จะผสมแบบลดช่องเสียงให้ซึ่งในกรณีเสียง
รอบทิศจะก้าหนดได้ว่าจะให้ใช้ช่องด้านหน้า ด้านหลังหรือจะรวมช่องความถี่ต่้า (LFE) มาผสมด้วยหรือไม่
โดยก้าหนดได้จากหัวข้อ 5.1 Mixdown Type ของค้าสั่ง Edit>Preference>Audio 

8.  ช่องทางเข้าของลู่ ปกติจะเป็นรายช่ือของการ์ดเสียงที่มีอยู่ในระบบมาให้เลือกเมื่อใช้ลู่นั้น ๆ 
บันทึกสียง 



41 

 

9.  ปุ่มปิดเสียง (mute) (รูป)   ส้าหรับปิดเสียงลู่ไม่ให้ออกไปผสมกับลู่อื่น ๆ , ปุ่มเล่นเดี่ยว (solo) 
(รูป) ใช้เมื่อต้องการให้ลู่นั้นมีเสียงส่วนลู่ลื่นที่ไม่เลือกเล่นเดียวไว้จะถูกปิดหมด, และสุดท้ายคือ ปุ่มเปิดทาง 
(enable) (รูป) ให้บันทึกเสียงใช้คู่กับปุ่มบันทึกในข้อ 12 เพื่อบันทึกเสียงลงบนลู่ในขณะที่มีการเปิดดูลู่ภาพ
ไปด้วยพร้อมกัน (voice over) 

10.  เครื่องวัดและแถบปรับระดับเสียง ใช้ปรับระดับเสียงที่ส่งออกจากลู่โดยมีแถบบอกระดับ
สัญญาณเสียง (VU meter) อยู่ด้านหน้า ในการปรับระดับเสียง นอกจากจะใช้วิธีเลื่อนแถบ (fader) ขึ้นลง
แล้วยังสามารถคลิกเลื่อนตัวเลขด้านล่างแถบเลื่อนหรือคลิกพิมพ์ตัวเลขไปโดยตรงก็ได้ (-80 ถึง +6) จ้านวน
แถบบอกระดับสัญญาณของแต่ละลู่ยังแสดงถึงจ้านวนช่องเสียงของลู่นั้นว่าเป็นแบบโมโน สเตอริโอ หรือ
เสียงรอบทิศ (5.1) อีกด้วย 

11.  ช่องก้าหนดลู่ออก ทางเลือกในการส่งออกของลู่ว่าจะส่งไปให้ลู่ใด ลู่ที่จะรับสัญญาณนี้ปกติจะ
เป็นลู่เสียงหลักและซับมิกซ์ การส่งออกจะไปยังลู่ทางขวามือเสมอเพื่อป้องกัน 
การวนของสัญญาณขึ้นโดยเฉพาะลู่ที่เป็นซับมิกซ์ด้วยกัน 

12.เครื่องมือควบคุมการเล่น/บันทึก (transport control): เหมือนกับเครื่องมือที่อยู่บนจอเซอร์ส หรือ
โปรแกรมเพียงแต่มีปุ่มบันทึก (record) เพิ่มขึ้นเท่านั้น 

การท างานกับเสียง 
เสียงเป็นปรากฏการณ์ที่จับต้องไม่ได้ ไม่อยู่ตลอดเวลา ถ้าเราสามารถแปลงเสียงให้เป็นภาพที่จับ

ต้องได้ก็จ้าท้าให้การท้างานสะดวกขึ้น โปรแกรมตัดต่อส่วนใหญ่จึงมีโหมดแสดงคลิปเสียงให้อยู่ในรูปของ
รูปคลื่น(waveform) เพื่อความสะดวกในการจัดการความสูงของรูปคลื่นจะหมายถึงความดังส่วนความชิด
กันของเส้นคลื่นหรือความถี่จะบอกถึงเสียงสูงหรือต่้า ด้วยรูปคลื่นนี้เราสามารถประมาณได้ว่าเสียงที่ได้ยิน
น่าจะอยู่ที่ต้าแหน่งใด กรณีบนไทม์ไลน์เราจะเปิดรูปคลื่นได้จากปุ่มเลือกสไตล์ (set display style) ที่บริเวณ
หัวลู่(ดูขั้นตอนที่ 3หัวข้อการวางคลิปบนไทม์ไลน์ ) เราอาจจะต้องย่อขยายซีเควนซ์และปรับความสูงของลู่
เพื่อจะได้มองเห็นรูปคลื่นชัดเจน นอกจากจะดูรูปคลื่นบนไทม์ไลน์แล้วเรายังดูรูปคลื่นเสียงได้ขณะที่อยู่บน
จอเซอร์สโดยเลือก Audio waveform จากค้าสั่งพาแนล 

 ตรวจเช็คและปรับแถบเลื่อนระดับความดังของลู่หลักในเครื่องผสมเสียงไม่ให้ต่้ากว่าระดับ 
0 dB หรือสูงเกินไป (เกิดเครื่องหมายสัญญาณถูกตัดยอดสีแดง ) หากความดังยังไม่เพียงพออาจจะต้องปรับ
ความดังของคลิปช่วยตามความจ้าเป็น 

 การปิดเสียงของลู่ที่ไม่ต้องการช่ัวคราวโดยใช้ปุ่มปิดเสียง  (mute) ในเครื่องผสมเสียง หรือ
ปุ่มสลับเปิดปิดทางออกเสียง  (toggle tract output) บนไทม์ไลน์  ส้าหรับการปิดเสียงของลู่อื่นๆชั่วคราวให้
ใช้ปุ่มเล่นเดี่ยว (solo) ในเครื่องผสมเสียงเฉพาะลู่ที่ก้าหนดให้เล่นเดี่ยวเท่านั้นจึงจะมีเสียงออก 

 ในการปรับแต่งเสียงใดๆให้ตัดสินใจก่อนว่าจะปรับเสียงนั้นทั้งลู่หรือเฉพาะคลิปเพราะการ
ปรับทั้งลู่กับการปรับเฉพาะคลิปนั้นมีความแตกต่างกัน 
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 เพื่อประหยัดพื้นที่แสดงลู่ที่ต้องการปรับแต่งบนเครื่องผสมเสียงเท่านั้นโดยใช้ค้าสั่งซ่อน /
แสดงลู่ (Show/Hide Track) ของเครื่องผสมเสียง นอกจากนั้นให้ปิดส่วนเอฟเฟ็กต์และช่องส่งสัญญาณออก
หากไม่ได้ใช้งานด้วย โดยคลิกสามเหลี่ยมที่ขอบซ้ายของเครื่องผสมเสียง 

 
การดึงเสียงออกจากคลิป 
เราสามารถดึงเฉพาะเสียงออกจากคลิปวิดีโอหรือคลิปเสียงในรูปแบบใดๆแล้วสร้างเป็น 

คลิปเสียงใหม่ในโครงการได้โดยใช้ค้าสั่ง Clip>Audio Option>Extract Audio จากแถบเมนู หลังจากเลือก
คลิปที่ต้องการบนโครงการแล้ว คลิปใหม่ที่เกิดขึ้นจะรักษาคุณสมบัติที่ใส่ให้กับคลิปเดิมเช่น ความยาว 
ความเร็ว อัตราการขยาย การแปลความหมาย (interpret footage) ไว้เหมือนเดิม 

 
การเรนเดอร์และแทนที่คลิป 
คลิปเสียงในซีเควนซ์ใส่เอฟเฟ็กต์และปรับแต่งจนเป็นที่พอใจแล้วสามารถเรนเดอร์เป็น 

คลิปใหม่แล้วแทนที่คลิปเดิมในซีเควนซ์เพื่อลดภาระการท้างานของระบบการเรนเดอร์และแทนที่โดยใช้
ค้าสั่ง Clip>Audio Options>Render and Replace จากแถบเมนูหลังจากเลือกคลิปที่ต้องการบนซีเควนซ์แล้ว 

 
การแตกเสียงให้เป็นโมโนหลายคลิป 
กรณีที่ต้องการจัดการคลิปเสียงที่มีช่องเสียงหลายช่องอย่างอิสระ เราจ้าเป็นต้องแตกเป็นเหล่านั้น

ซึ่งอาจจะเป็นเสียงสองช่องสเตอริโอ หรือแบบเสียงรอบทิศ  5.1 ช่อง ออกเป็นเสียงโมโนสองคลิปหรือหก
คลิปเสียก่อน การแตกคลิปท้าโดยค้าสั่ง Clip>Audio Options>Break to mono หลังจากเลือกคลิปที่ต้องการ
บนโครงการแล้ว คลิปใหม่ที่ได้จะยังไม่เช่ือมโยงกัน หากต้องการให้โมโนคลิปเหล่านั้นเช่ือมโยงกันจะต้อง
เลือกคลิปทั้งหมดแล้วใช้ค้าสั่ง Link เอง 

 
การใส่เอฟเฟ็กต์และทรานซิชันให้กับเสียง 
วิธีการใส่เอฟเฟ็กต์และทรานซิชันให้กับคลิปเสียงได้อธิบายไว้แล้วในขั้นตอนที่ 5 และในหัวข้อ 

เครื่องผสมเสียงที่ผ่านมาเอฟเฟ็กต์เสียงจะแบ่งออกเป็นสามกลุ่มตามจ้านวนช่องเสียงคือ กลุ่มโมโน สเตอริ
โอ และเสียงรอบทิศ รายการของแต่ละกลุ่มจึงต่างกันเล็กน้อย เช่น Channel Volume จะไม่มีในกลุ่มโมโน
หรือ Fill Left, Fill Right จะไม่มีในกลุ่มโมโนและเสียงรอบทิศ เป็นต้น วิธีการปรับแต่งเอฟเฟ็กต์เสียงต่างๆ
จะน้ามาอธิบายในโอกาสต่อไปเนื่องจากมีรายละเอียดที่เกี่ยวข้องมากมาย ในส่วนทรานซิชันของเสียง จะมี 
Crossfede เพียงกลุ่มเดียวโดยแบ่งออกเป็นสองแบบคือ Constant Gain กับ Constant Power ข้อแตกต่างก็คือ 
Constant Gain จะมีการเปลี่ยนเสียงในอัตราที่คงที่ซ่ึงไม่สอดคล้องกับการรับฟังของมนุษย์ที่เป็นแบบ
ลอการิทึม การเปลี่ยนเสียงจึงกระชากเร็วกว่าแบบ Constant Power ที่จะนุมนวลสอดคล้องกับการท้าภาพ
จางซ้อนมากกว่าเมื่อดูจาดเส้นความดังแล้ว Constant Power จะลดความดังของคลิปแรกลงอย่างช้า ๆ 



43 

 

ในช่วงแรกและตกลงอย่างรวดเร็วในช่วงหลัง ขณะคลิปหลังจะเพิ่มความดังอย่างรวดเร็วในช่วงแรกและ
ค่อย ๆเข้าสู่จุดสูงสุดในช่วงหลังสุดอย่างช้า ๆ 

การใส่ทรานซิชันของเสียงบริเวณหัวหรือท้ายคลิปแทนที่จะวางตรงรอยต่อของคลิปจะเป็นการ
ท้าเฟดอินหรือเฟอเอาต์ให้กับคลิปเสียงนั้น ๆ นอกจากการใช้ทรานซิชันแล้ว การจางซ้อนหรือเฟดยังท้าได้
โดยการปรับเส้นกราฟคีย์เฟรมความดังเสียงของคลิปหรือของลู่เองดังกล่าวมาแล้วอีกรอบ 
 

การบันทึกเสียง 
เราสามารถบันทึกเสียงลงบนไทม์ไลน์โดยตรงในขณะฟรีวิวภาพหรือเสียงบนลู่อื่น ๆ ไปพร้อมกัน 

อย่างไรก็ตามการจะกระท้าแบบนี้ได้จะต้องอาศัยทางเข้าบนการ์ดเสียงพร้อมกับไดร์เวอร์ ASIO (audio 
stream input /output) ซึ่งเป็นโพรโตคอลในการเช่ือมต่อโปรแกรมประยุกต์ (ในที่นี้คือพรีเมียร์ ) กับการ์ด
เสียงโดยไม่ต้องผ่านทางระบบปฏิบัติการที่มีข้อจ้ากัด 

การบันทึกจะกระท้าผ่านช่อง Default Device ที่ระบุไว้ในรายการ Audio Hardware ของค้าสั่ง 
Edit>Preferences กล่องสนทนายังรวมการต้ังค่า ASIO เพื่อเปิดทางเข้าที่ต่อกับคอมพิวเตอร์ กรณีที่การ์ด
เสียงไม่มีไดร์เวอร์ ASIO มาให้ ให้เลือก Premiere Pro Windows Sound แทน 

ล้าดับการบันทึกเสียงเร่ิมจากการเปิดพาเเนล Audio Mixer แล้วคลิกปุ่มเปิดทาง (รูปไมโครโฟน ) 
ของลู่เสียงที่ต้องการบันทึก รายการช่องเข้าของลู่จะปรากฏให้เลือกเหนือปุ่มบันทึกเสียง (ส้าหรับเครื่องที่มี
การ์ดเสียงธรรมดาเพียงการ์ดเดียวจะเห็นเพียงรายการเดียว ) เพื่อป้องกันเสียงจากล้าโพงป้อนกลับสู่
ไมโครโฟนเราอาจจะต้องปิดเสียงจากล้าโพงก่อนโดย คลิกเลือกหัวข้อ Mute input during timeline 
recording ในหัวข้อ Audio จากค้าสั่ง Edit>Preference ข้อควรระวัง ลู่ที่บันทึกจะต้องสอดคล้องกับช่อง
ทางเข้าที่ใช้ เช่น ช่องไมโครโฟนที่เป็นโมโนฏควนบันทึกบนลู่ที่เป็นโมโนด้วยเช่นกัน หากต้องการบันทึก
หลายลู่พร้อมกันก็ตต้องปฏิบัติกับลู่อื่น ๆ ในลักษณะเดียวกัน ก่อนการบันทึกให้ปรับระดับเสียงเข้าให้
เหมาะสมกับการบันทึก จากนั้นจึงคลิกปุ่มบันทึก(รูป) (สีแดง) เพื่อเข้าสู่โดยบันทึก เลื่อนเข็มช้ีเวลาบนไทม์
ไลน์ไปยังต้าแหน่งที่จะบันทึก หรือก่อนที่จะบันทึกเล็กน้อยกรณีจะบันทึกเสียงทับจากไมโครโฟนเมื่อทุก
อย่างพร้อมให้คลิกปุ่มเล่น (รูป) (play) ภาพและเสียงในลู่อื่นถ้ามีและไม่ได้ปิดไว้จะเปิดออกมาเพื่อบอก
ต้าแหน่งที่จะบันทึกสัญญาณเสียงให้เข้าจังหวะกับภาพและเสียงเดิม (ถ้ามี) ในช่วงนี้โปรเกรมจะบันทึกไป
เร่ือย ๆ จนกว่าจะกดปุ่มหยุด(รูป) คลิปเสียงที่บันทึกได้จะเกิดขึ้นบนพาแนล Project และวางอยู่บนลู่ที่เลือก
ไว้ด้วย 
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ข้ันที่ 7 การส่งผลงานออก (export) ในรูปแบบต่าง ๆ 
เมื่อการตัดต่อเสร็จ ขั้นตอนสุดท้ายคือการส่งงานออก (export) ไปใช้งายหรือเผยแพร่ในรูปต่าง ๆ 

เช่น เทป วีซีดี ดีวีดี หรือเป็นแฟ้มภาพและเสียงชนิดต่าง ๆ งานบางประเภทที่ต้องการความถูกต้องของ
สัญญาณสูง เช่น งานออกอากาศจากสถานีโทรทัศน์ เราอาจจะต้องขยับคลิปบนไทม์ไลน์ออกไปเพื่อแทรก
ซีนน้า เช่น แถบสีทดสอบซีนนับถอยหลัง รวมทั้งสัญญาณมืด ก่อนเข้าสู่เนื้อหาจริง คลิปเหล่านี้เราสามารถ
สร้างได้ง่าย ๆ จากค้าสั่ง File>New ซึ่งจะมีรายการ Bars and Tone, Blank Video, Color Matte, Universal 
Counting Leader, และ Transparent Video ให้เลือกใช้ตามความเหมาะสม ส้าหรับงานที่ต้องการเผยแพร่
ไปสู่ผู้ใช้ตามบ้าน (consumer) เป็นหลักเช่น ในรูปของวีซีดีและดีวีดี สัญญาณเหล่านี้จะไม่ได้ใช้งาน จึงไม่มี
ความจ้าเป็นที่จ้าต้องน้ามาใส่ไว้ 

ค าสั่ง File>Export จะมีทางเลือกต่าง ๆดังนี้ 
-  Movie:  เป็นการสร้างแฟ้มข้อมูลชนิดต่าง ๆ ออกมาจากซีเควนซ์ที่ตัดต่อไว้ปกติคือแฟ้ม AVI แต่

เราสามารถเลือกได้เป็นแฟ้มชนิดอื่น Quick Time, filmstrip, Animate GIF หรือเป็นแฟ้มภาพนิ่งหลาย ๆ
ภาพ (BMP, TIFF, Targa) ก็ได้ โดยการคลิก Setting ในกล่องสนทนาของ Export Movie นอกจากท่านจะ
เลือกชนิดแฟ้มของภาพยนตร์ แล้วยังก้าหนดวิธีการบีบอัดภาพ จ้านวนสี ขนาด (ขึ้นอยู่กับชนิดแฟ้มที่เลือก ) 
รวมทั้งพารามิเตอร์ของเสียงได้อีกด้วย 

-  Frame:  เป็นการสร้างภาพนิ่งหนึ่งภาพจากไทม์ไลน์ที่ต้าแหน่งเข็มช้ีเวลาขณะนั้น ชนิดของแฟ้ม
สามารถเลือกเป้น BMP, Targa, GIF และTIFF ท่านสามารถก้าหนดขนาดภาพและอัตราส่วนจุดภาพเพื่อให้
ภาพที่ออกไปเหมาะสมกับการใช้งาน (กรณีที่คลิปเป็น DV PAL จะมีขนาด 720x576 โดยมีอัตราส่วน
จุดภาพเป็น 1:1.067 หากน้าไปใช้งานร่วมกับภาพอื่นที่ใช้อัตราส่วนจุดภาพแบบจตุรัส (square pixel) ภาพ
จะไม่สมส่วน เราอาจจะต้องเปลี่ยนขนาดเป็น 768ป576 ส้าหรับจุดภาพแบบจตุรัส ก่อนที่จะส่งภาพออกไป) 

-  Audio:  กรณีที่ต้องการเฉพาะเสียงของซีเควนซ์อย่างเดียว 
-  Title:  เป็นการสร้างไฟล์ไตเติ้ลแยกอิสระออกมาจากโครงการ โดนปกติเมื่อสร่างไตเติ้ลจาก

เครื่องมือของพรีเมียร์จะเกิดคลิปขึ้นในดครงการ แต่คลิปนี้ไม่มีแฟ้มเฉพาะที่จะน้าออกไปใช้งานภายนอก
ได้ ค้าสั่งนี้จะใช้ได้เมื่อเลือกคลิปไตเติ้ลตั้งแต่หนึ่งตัวขึ้นไปในพาแนล Project เสียก่อน 

-  Export to Tape:  ค้าสั่งนี้จะท้างานก็ต่อเมื่อพรีเมียร์พบว่ามีเทป (หรือกล้องที่ท้าหน้าที่เป็นเทป ) 
ติดตั้งและเปิดท้างาน (Online) อยู่ในระบบ 

-  Export to DVD:  พรีเมียร์รุ่นปัจจุบันสามารถส่งออกในรูปของดีวีดได้ทันที โดยมีทางเลือกสาม
ทางคือ เขียนแผ่นดีวีดีทันที (Burn to Disc)  กรณีที่ระบบมีเครื่องเขียนดีวีดีต่ออยู่ เราสามารถเลือกจ้าวนแผ่น
ที่จะเขียนได้แต่เมื่อเขียนเสร็จพรีเมียร์จะไม่เก็บข้อมูลเหล่านี้ไว้ หากต้องการเก็บไว้ใช้งานในอนาคตควรจะ
เลือกทางเลือกอื่น คือเขียนเป็นโฟลเดอร์ (Burn to Folder) พรีเมียร์จะให้เราก้าหนดช่ือและต้าแหน่งของ
โฟลเดอร์ หลังจากนั้นก็จะสร้างแฟ้มต่าง ๆ เหมือนกับที่จะเขียนลงบนดีวีดี เราจะต้องน้าไฟล์เหล่านี้ไปเขียน
ลงบนแผ่นดีวีดีเองด้วยโปรแกรมเขียนดีวีดีที่มีอยู่ในต้องตลาด ส่วนวิธีสุดท้ายคือการเขียนเป็นดีวีดีอิมเมจ 
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(Burn to ISO Image) คล้ายกับวิธีที่สอง แต่แฟ้มทื่ได้จะเป็นแฟ้มเดียวโดด ๆ จึงเหมาะส้าหรับการส่งแฟ้มไป
เขียนที่อื่น เช่นส่งไปท้าส้าเนาจ้านวนมาก โปรแกรมที่จะน้าแฟ้มนี้ไปเขียนต้องรู้จักโครงสร้างของดีวีดี
อิมเมจเพื่อที่จะแตกเป็นแฟ้มต่าง ๆ ออกมาได้ ก่อนที่ท้าการเขียนลงบนแผ่นดีวีดีต่อไป  ในหน้า Setting ของ 
Export to DVD เราสามารถเลือกอัตราบิตของการเข้ารหัสภาพรูปแบบของเสียง จากชุดที่ก้าหนดไว้ล่วงหน้า 
หรือจะปรับแต่งเองอย่างอิสระ นอกจากท่านจะเขียนดีวีดีด้วยวิธีเหล่านี้ ท่านยังเขียนดีวีดีแบบมีเมนูง่าย ๆ 
โดยใช้ค้าสั่ง Window>DVD Layout ซึ่งจะมีรูปแบบเมนุง่าย ๆ ให้เลือกใช้จ้านวนหนึ่ง ในการใช้งานเราต้อง
ไปก้าหนดเครื่องหมายดีวีดี (DVD Marker) บนไทม์ไลน์เสียก่อนซึ่งมีอยู่สามแบบด้วยกันคือ Menu ส้าหรับ
ต้าแหน่งที่จะเข้าสู่เมนู, Scene ส้าหรับเป็นจุดแบ่งตอน (chapter) ต่าง ๆ , และสุดท้าย Stop เป็นจุดจบหรือจุด
ที่จะย้อนกลับไปหาต้าแหน่ง Menu ค้าสั่งก้าหนดเครื่องหมายดีวีดีเรียกจาก Marker>Set DVD Marker บน
แถบเมนู หรือจะคลิกปุ่มก้าหนดเครื่องหมายดีวีดี (Set DVD Marker)  ใต้ตัวเลขรหัสเวลาบอกต้าแหน่างเข็ม
ช้ีเวลาบนไทม์ไลน์ ก็ได้เช่นกัน 

-  Export to EDL:  EDL ย่อมาจาก Edit Decision List หมายึงตารางการตัดต่อที่ประกอบด้วย
รายละเอียดของคลิปที่น้ามาล้าดับกันเช่น ช่ือเทป รหัสเวลา ทรายซิชันที่ใช้ เป็นต้น EDL ใช้ส้าหรับงานตัด
ต่อจากเครื่องหนึ่งไปตัดต่อใหม่ยังอีกเครื่องหนึ่งที่แตกต่างกัน ในอดีตเราจะท้าการตัดหยาบด้วย
คอมพิวเตอร์ซึ่งจะให้งานคุณภาพไม่ดีนักอันเป็นข้อจ้ากัดของระบบในยุคนั้นจากนั้นจึงส่ง DEL ไปตัดต่อ
ใหม่พร้อมกับฟุตเทจต้นฉบับคุณภาพสูงในเครื่องที่เป็นระบบออนไลนื พรีเมียร์รุ่นก่อน ๆ จะสนับสนุน
EDL หลายรูปแบบ แต่เนื่องจาการนิยมในการใช้ EDL ลดลง ปัจจุบันพรีเมียร์จึงสนับสนุนเฉพาะ EDL ของ
เครื่อง CMX 3600 ที่ยังคงมีการใช้งานกันอยู่ 

-  Adobe Media Encoder:  เป็นการส่งออกในรูปของแฟ้มข้อมูลที่เลือกไดหลากหลาย ท่าสามารถ
สร้างแฟ้มที่มีอัตราข้อมูลต่้า ๆ ที่ใช้บนอินเทอร์เน็ต จนถึงคุณภาพระดับความชัดสูง การส่งออกดีวีดีที่กล่าว
มาแล้วก็อาศัยทางเลือกหนึ่งใน Adobe Media Encoderนี้ เช่นกัน เมื่อท่านต้องการรูปแบบแฟ้มสื่อต่อไปนี้ 
WMV, MPEG-1, MPEG-2, Quick Time, Flash, Real Media ทางเลือกนี้จะเหมาะสมที่สุด 
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